COMOS Platform
COMOS Platform Getting Started

Getting Started

Trademarks 1
Welcome to COMOS 2
Starting COMOS 3
Availability of information 4
Opening the database and project 5
Working layers 6
Definition of the term "object" 7
COMOS basic operation 8
Navigator 9
Properties of an object 10
Base objects through the symbol bar 11
Structure engineering (new engineering objects) 12
Searching for objects 13
Editing engineering data 14
Object queries 15
Bulk processing for engineering objects 16
Status management 17
Documents 18
Reports 19
Revisions 20
All document tools 21
Switching language 22
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**

indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**

indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**

indicates that an unintended result or situation can occur if the relevant information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by © are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Trademarks</td>
<td>9</td>
</tr>
<tr>
<td>2 Welcome to COMOS</td>
<td>11</td>
</tr>
<tr>
<td>3 Starting COMOS</td>
<td>13</td>
</tr>
<tr>
<td>3.1 Start methods</td>
<td>13</td>
</tr>
<tr>
<td>3.2 Start interface</td>
<td>13</td>
</tr>
<tr>
<td>3.3 Coming up next</td>
<td>14</td>
</tr>
<tr>
<td>4 Availability of information</td>
<td>15</td>
</tr>
<tr>
<td>4.1 Projects</td>
<td>15</td>
</tr>
<tr>
<td>4.1.1 Definition</td>
<td>15</td>
</tr>
<tr>
<td>4.1.2 Project types</td>
<td>16</td>
</tr>
<tr>
<td>4.1.3 Use of projects</td>
<td>16</td>
</tr>
<tr>
<td>4.2 Working layers</td>
<td>17</td>
</tr>
<tr>
<td>4.2.1 Definition</td>
<td>17</td>
</tr>
<tr>
<td>4.2.2 Use</td>
<td>18</td>
</tr>
<tr>
<td>4.3 Coming up next</td>
<td>18</td>
</tr>
<tr>
<td>5 Opening the database and project</td>
<td>19</td>
</tr>
<tr>
<td>5.1 Selecting a database</td>
<td>19</td>
</tr>
<tr>
<td>5.2 Logging into the database</td>
<td>20</td>
</tr>
<tr>
<td>5.3 Select a project</td>
<td>22</td>
</tr>
<tr>
<td>5.4 Quicklaunch</td>
<td>23</td>
</tr>
<tr>
<td>5.5 Coming up next</td>
<td>23</td>
</tr>
<tr>
<td>6 Working layers</td>
<td>25</td>
</tr>
<tr>
<td>6.1 Working layer selection</td>
<td>25</td>
</tr>
<tr>
<td>6.1.1 Tabs</td>
<td>25</td>
</tr>
<tr>
<td>6.1.2 Commands in the context menu</td>
<td>26</td>
</tr>
<tr>
<td>6.1.3 Managing working layers</td>
<td>27</td>
</tr>
<tr>
<td>6.2 Using Working Layers</td>
<td>28</td>
</tr>
<tr>
<td>6.2.1 Basic working techniques</td>
<td>28</td>
</tr>
<tr>
<td>6.2.2 Collisions</td>
<td>29</td>
</tr>
<tr>
<td>6.2.3 Release</td>
<td>29</td>
</tr>
<tr>
<td>6.3 Working layer display</td>
<td>29</td>
</tr>
<tr>
<td>6.3.1 Object status</td>
<td>30</td>
</tr>
<tr>
<td>6.4 Coming up next</td>
<td>31</td>
</tr>
<tr>
<td>7 Definition of the term &quot;object&quot;</td>
<td>33</td>
</tr>
<tr>
<td>7.1 Constituent parts of objects in COMOS</td>
<td>33</td>
</tr>
</tbody>
</table>
# Table of contents

7.1.1 The basic idea of an object ................................................................. 33
7.1.2 Display of objects in COMOS ............................................................ 33
7.1.2.1 Icons ........................................................................................ 33
7.1.2.2 Symbols .................................................................................... 34
7.1.2.3 Name, label and text ................................................................. 34
7.1.2.4 Identifying objects .................................................................... 35
7.1.3 The properties of an object .............................................................. 35
7.2 Subdivision of objects ......................................................................... 36
7.2.1 System types of objects ................................................................... 36
7.2.2 Object classes ................................................................................ 37
7.2.3 Document types ............................................................................. 37
7.3 Coming up next .................................................................................. 37

8 COMOS basic operation ........................................................................ 39
8.1 Basic terms ......................................................................................... 39
8.2 The interface ....................................................................................... 41
8.3 Operator control ................................................................................ 43
8.3.1 Changing the tab order ................................................................... 43
8.3.2 Creating a new tab ......................................................................... 44
8.3.3 Moving tabs into another frame .................................................... 46
8.3.4 Separate frames for working area and Navigators ...................... 47
8.3.5 Splitting frames ............................................................................ 49
8.3.6 Closing tabs .................................................................................. 50

9 Navigator ............................................................................................... 51
9.1 Overview ............................................................................................ 51
9.2 Navigator interface ............................................................................. 52
9.2.1 Tabs of the Navigator ..................................................................... 52
9.2.2 Commands in the context menu of the Navigator ....................... 53
9.2.2.1 "Navigator settings" command ............................................. 53
9.2.2.2 "Status display" command .......................................................... 54
9.2.2.3 "Working layer display mode" command ................................. 54
9.2.2.4 The "History display" command .............................................. 55
9.2.2.5 "Legend" command ................................................................. 55
9.3 Mouse operation in the Navigator ..................................................... 56
9.3.1 Selecting ....................................................................................... 56
9.3.2 Drag&Drop ................................................................................... 56
9.3.3 Double-clicking ............................................................................ 57
9.3.4 Functions in the context menu ...................................................... 57
9.3.5 "Navigate" context menu ............................................................... 58
9.4 Coming up next ................................................................................ 59

10 Properties of an object ....................................................................... 61
10.1 Structure ......................................................................................... 61
10.2 Toolbar ............................................................................................ 62
10.3 General data area ............................................................................. 63
10.4 Reference fields .............................................................................. 64
# Table of contents

10.4.1 General .................................................................................................................. 64
10.4.2 Examples of references .......................................................................................... 65
10.4.3 Alternative configuration of reference fields ....................................................... 66
10.5 Tabs of the engineering object .................................................................................. 66
10.6 Buttons ....................................................................................................................... 67
10.7 Coming up next .......................................................................................................... 67
11 Base objects through the symbol bar ......................................................................... 69
  11.1 Symbol bar ............................................................................................................... 69
  11.2 Creating a symbol bar .............................................................................................. 69
  11.3 Using a symbol bar in the report .............................................................................. 72
  11.4 Coming up next ........................................................................................................ 72
12 Structure engineering (new engineering objects) ....................................................... 73
  12.1 The idea behind structure engineering .................................................................... 73
  12.2 Possibility 1: Free structure engineering ................................................................ 73
    12.2.1 First level: Creating a new unit / new location ............................................. 73
    12.2.2 Further levels in free structure engineering ............................................... 75
  12.3 Possibility 2: Labelling system ............................................................................... 76
  12.4 General objects ....................................................................................................... 77
    12.4.1 Creation .......................................................................................................... 77
    12.4.2 Setting the base object .................................................................................... 77
  12.5 Assigning engineering objects (reference) ............................................................. 78
  12.6 Preparations ............................................................................................................ 79
  12.7 Mixing units and locations ..................................................................................... 79
  12.8 Coming up next ........................................................................................................ 80
13 Searching for objects .................................................................................................. 81
  13.1 Searching for engineering objects ........................................................................ 81
    13.1.1 Opening a dialog window .............................................................................. 81
    13.1.2 "Search" tab ..................................................................................................... 81
    13.1.3 "Options" tab ................................................................................................... 82
    13.1.3.1 Database-based search ........................................................................... 82
    13.1.3.2 Search in the Navigator text ................................................................... 83
    13.1.4 Examples for searching with placeholders .................................................. 83
  13.2 Object queries ......................................................................................................... 86
  13.3 Coming up next ........................................................................................................ 86
14 Editing engineering data ............................................................................................. 87
  14.1 Basic state of the properties .................................................................................... 87
  14.2 "General" tab .......................................................................................................... 87
  14.3 "Attributes" tab ....................................................................................................... 88
    14.3.1 Purpose .......................................................................................................... 88
    14.3.2 Entering values manually ............................................................................. 89
Table of contents

14.3.3 Copying data manually..........................................................................................................................90
14.3.4 Data flow (static links) ..........................................................................................................................91
14.3.4.1 "Refresh ... static links" commands...............................................................................................92
14.3.4.2 "Static links: Accept differences..." commands ...............................................................................92
14.3.5 Working with tables ............................................................................................................................93
14.3.6 Read-only mode......................................................................................................................................94
14.4  "Elements" tab........................................................................................................................................95
14.4.1 Purpose ................................................................................................................................................95
14.4.2 Hierarchy of the engineering data ........................................................................................................96
14.4.3 Inherited elements .................................................................................................................................96
14.4.4 Commands on the "Elements" tab .........................................................................................................98
14.5  "Connectors" tab ....................................................................................................................................99
14.5.1 Purpose and interface ..........................................................................................................................99
14.5.2 Usage ..................................................................................................................................................99
14.5.2.1 Setting connectors using drag&drop ............................................................................................99
14.5.2.2 Context menu ................................................................................................................................100
14.5.3 Saving the settings (scheme) ..............................................................................................................101
14.6  Coming up next ......................................................................................................................................101

15  Object queries .........................................................................................................................................103
15.1  Purpose ..................................................................................................................................................103
15.2  General data ..........................................................................................................................................104
15.3  Toolbar ..................................................................................................................................................104
15.4  Object browser ....................................................................................................................................105
15.4.1 Changing the order of the columns ......................................................................................................105
15.4.2 Changing the row height ......................................................................................................................106
15.4.3 Changing the column width ................................................................................................................106
15.4.4 Sorting the object list..........................................................................................................................107
15.4.5 Filtering the object list .........................................................................................................................107
15.4.6 Displaying and editing attributes in the object list .............................................................................108
15.5  Working within object queries ..............................................................................................................109
15.6  Deleting in the list ................................................................................................................................109
15.7  Coming up next ....................................................................................................................................110

16  Bulk processing for engineering objects ...............................................................................................111
16.1  Purpose ..................................................................................................................................................111
16.2  Interface ...............................................................................................................................................111
16.3  Carrying out a bulk processing operation .............................................................................................112
16.3.1 Setting starting values .........................................................................................................................112
16.3.2 Collecting attributes ...........................................................................................................................112
16.3.3 Saving the inputs ...............................................................................................................................114
16.3.4 Marking objects ................................................................................................................................114
16.3.5 The context menu in the right area of bulk processing ....................................................................115
16.3.6 Changing general data and attributes ...............................................................................................116
16.3.7 Completing the bulk processing .........................................................................................................116
16.4  Coming up next ....................................................................................................................................116
## 17 Status management

17.1 Status information

17.1.1 Status

17.1.2 Status value

17.2 Using status management

17.2.1 Initial status value

17.2.2 Setting the status in the properties

17.2.3 Setting the status in the Navigator

17.2.4 Automatic status change

17.2.5 Status calculation protocol

17.3 Coming up next

### 19 Reports

19.1 Report types

19.2 Basic functions in all reports

19.2.1 General functions

19.2.2 Zoom functions

19.3 Interactive Reports

19.3.1 Mouse operation on the report

19.3.1.1 Drag&Drop

19.3.1.2 Mouse movements

19.3.1.3 Important context menus in interactive reports

19.3.2 Buttons in interactive reports

19.3.3 Placing objects

19.3.3.1 Overview

19.3.3.2 Through the symbol bar for base objects

19.3.3.3 Via the "Base objects" tab

19.3.3.4 From the engineering data

19.3.3.5 Placing templates

19.3.3.6 Result in the database

19.3.4 Symbol operations on interactive reports

19.3.4.1 Move

19.3.4.2 Scaling and rotating

### 18 Documents

18.1 Definition of documents

18.2 Document storage

18.3 Inherited documents

18.4 Opening documents

18.5 Using external documents in COMOS

18.6 "New document" command

18.6.1 Select the document type

18.6.2 Reports

18.6.2.1 Evaluation Reports

18.6.2.2 Interactive Report

18.6.3 External documents (default interface)

18.7 Coming up next

---

**Table of contents**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>17 Status management</td>
<td>117</td>
</tr>
<tr>
<td>17.1 Status information</td>
<td>117</td>
</tr>
<tr>
<td>17.1.1 Status</td>
<td>117</td>
</tr>
<tr>
<td>17.1.2 Status value</td>
<td>117</td>
</tr>
<tr>
<td>17.2 Using status management</td>
<td>118</td>
</tr>
<tr>
<td>17.2.1 Initial status value</td>
<td>118</td>
</tr>
<tr>
<td>17.2.2 Setting the status in the properties</td>
<td>118</td>
</tr>
<tr>
<td>17.2.3 Setting the status in the Navigator</td>
<td>120</td>
</tr>
<tr>
<td>17.2.4 Automatic status change</td>
<td>121</td>
</tr>
<tr>
<td>17.2.5 Status calculation protocol</td>
<td>121</td>
</tr>
<tr>
<td>17.3 Coming up next</td>
<td>121</td>
</tr>
<tr>
<td>18 Documents</td>
<td>123</td>
</tr>
<tr>
<td>18.1 Definition of documents</td>
<td>123</td>
</tr>
<tr>
<td>18.2 Document storage</td>
<td>123</td>
</tr>
<tr>
<td>18.3 Inherited documents</td>
<td>124</td>
</tr>
<tr>
<td>18.4 Opening documents</td>
<td>125</td>
</tr>
<tr>
<td>18.5 Using external documents in COMOS</td>
<td>125</td>
</tr>
<tr>
<td>18.6 &quot;New document&quot; command</td>
<td>126</td>
</tr>
<tr>
<td>18.6.1 Select the document type</td>
<td>126</td>
</tr>
<tr>
<td>18.6.2 Reports</td>
<td>127</td>
</tr>
<tr>
<td>18.6.2.1 Evaluation Reports</td>
<td>127</td>
</tr>
<tr>
<td>18.6.2.2 Interactive Report</td>
<td>128</td>
</tr>
<tr>
<td>18.6.3 External documents (default interface)</td>
<td>128</td>
</tr>
<tr>
<td>18.7 Coming up next</td>
<td>129</td>
</tr>
<tr>
<td>19 Reports</td>
<td>131</td>
</tr>
<tr>
<td>19.1 Report types</td>
<td>131</td>
</tr>
<tr>
<td>19.2 Basic functions in all reports</td>
<td>132</td>
</tr>
<tr>
<td>19.2.1 General functions</td>
<td>132</td>
</tr>
<tr>
<td>19.2.2 Zoom functions</td>
<td>132</td>
</tr>
<tr>
<td>19.3 Interactive Reports</td>
<td>133</td>
</tr>
<tr>
<td>19.3.1 Mouse operation on the report</td>
<td>133</td>
</tr>
<tr>
<td>19.3.1.1 Drag&amp;Drop</td>
<td>133</td>
</tr>
<tr>
<td>19.3.1.2 Mouse movements</td>
<td>134</td>
</tr>
<tr>
<td>19.3.1.3 Important context menus in interactive reports</td>
<td>134</td>
</tr>
<tr>
<td>19.3.2 Buttons in interactive reports</td>
<td>135</td>
</tr>
<tr>
<td>19.3.3 Placing objects</td>
<td>136</td>
</tr>
<tr>
<td>19.3.3.1 Overview</td>
<td>136</td>
</tr>
<tr>
<td>19.3.3.2 Through the symbol bar for base objects</td>
<td>137</td>
</tr>
<tr>
<td>19.3.3.3 Via the &quot;Base objects&quot; tab</td>
<td>139</td>
</tr>
<tr>
<td>19.3.3.4 From the engineering data</td>
<td>139</td>
</tr>
<tr>
<td>19.3.3.5 Placing templates</td>
<td>140</td>
</tr>
<tr>
<td>19.3.3.6 Result in the database</td>
<td>141</td>
</tr>
<tr>
<td>19.3.4 Symbol operations on interactive reports</td>
<td>141</td>
</tr>
<tr>
<td>19.3.4.1 Move</td>
<td>142</td>
</tr>
<tr>
<td>19.3.4.2 Scaling and rotating</td>
<td>142</td>
</tr>
</tbody>
</table>
# Table of contents

19.3.4.3 Distort .................................................................................................................. 143
19.3.4.4 Graphical properties ......................................................................................... 145
19.3.4.5 Editing symbol texts ......................................................................................... 145
19.3.4.6 Additional symbols / Subsymbols ...................................................................... 146
19.3.4.7 Freely editing symbols ....................................................................................... 148
19.3.4.8 Removing graphical changes ............................................................................. 148
19.4 Coming up next .............................................................................................................. 149

## 20 Revisions .................................................................................................................. 151

20.1 Revision of an individual document ............................................................................ 151
20.1.1 "Revisions" tab .............................................................................................................. 151
20.1.2 Carrying out a revision ............................................................................................. 152
20.1.2.1 Generating a revision ........................................................................................... 152
20.1.2.2 Revision steps ......................................................................................................... 153
20.1.2.3 Closing a revision .................................................................................................. 153
20.1.3 Controlling the revision text .................................................................................... 154
20.1.4 Monitoring revisions ............................................................................................... 155
20.2 Revisioning a document group ..................................................................................... 155
20.2.1 Group revision .......................................................................................................... 155
20.2.2 Operation .................................................................................................................. 155
20.2.2.1 Effect of a group revision ...................................................................................... 156
20.2.2.2 Deleting an open group revision ......................................................................... 156
20.2.2.3 Effective range of the group revision .................................................................. 157
20.2.3 Grouping of documents ............................................................................................ 157
20.2.3.1 Documents that have been taken in automatically .............................................. 157
20.2.3.2 Removing documents from the group revision .................................................... 157
20.2.3.3 Retrospectively including documents into a group revision ............................... 158
20.3 Coming up next .............................................................................................................. 159

## 21 All document tools ....................................................................................................... 161

21.1 Searching, printing and revising documents ................................................................. 161
21.2 Using all document tools ............................................................................................. 161
21.3 Options .......................................................................................................................... 162
21.4 Print .................................................................................................................................. 163
21.5 Revisioning ..................................................................................................................... 163
21.6 Other buttons .................................................................................................................. 164

## 22 Switching language ....................................................................................................... 165

22.1 General .......................................................................................................................... 165
22.2 Switching the user interface language .......................................................................... 166
22.3 Switching the project language ..................................................................................... 166
Welcome to COMOS

Do you work in the process engineering industry, in plant design and construction or in the electrical industry? Are you an engineer, technical draftsman, technician or service provider?

COMOS accompanies and facilitates your work during all project phases, regardless of whether you are currently working on design, assembly, commissioning or tasks in the maintenance phase, all the way to revisioning. COMOS supports you not only during the separate work phases, but also synchronizes all disciplines involved in engineering and execution, such as:

- Process engineering
- Conceptional design
- Pipe design
- Function design
- Automation and control system planning
- Electrical engineering, instrumentation and control
- Asset management / maintenance
- Document and project management

COMOS administration

As it is the case with all CAE systems, COMOS should be set up by a trained administrator and customized to company-specific needs. As a result, you will be able to work faster and in a more reliable manner, because the results are saved electronically and the software relieves you of a lot of routine work. Roughly speaking, there are two different ways of working with COMOS:

- The database-oriented form of working
  This work mainly involves individual data records and their relationships. Data structures are set up during this, texts, numbers or amounts are entered.

- The report-based working type
  Here you use “Electronic drawing sheets”. Besides that there are evaluation reports, such as lists and data sheets.
Starting COMOS

3.1 Start methods

Start menu / Launch via desktop

Double-click on the COMOS icon on the screen:

Alternatively, go to the Windows start group and click

"Start > Programs > COMOS > 9.2 > COMOS 9.2".

You find more information on this topic in the "Starting COMOS" manual, keyword "Start techniques".

3.2 Start interface

Overview

When you start COMOS, you see the following:

The exact appearance of the user interface depends on the version.
3.3 Coming up next

Overview

Very large amounts of data are regularly produced in connection with CAE projects. You need a database in order to manage large data volumes.

COMOS uses a database in the background. But you, as the user, have no direct contact with this database. Instead, COMOS offers you a series of intuitive and easy-to-use interfaces. The database operations are performed in the background.

One of the strengths of COMOS is that all information in the database can be divided and segmented on the basis of particular problems. This organization and segmentation is done with the help of two approaches:

- Data-related structure / availability of information
  This approach primarily covers the projects and the working layers. In the broader sense the COMOS object hierarchy and therefore the Navigator display is part of this approach.

- The user-specific structure by means of rights
  Rights management is only a form of access control. The information is there but you cannot access it if you do not have the rights.

See also

Availability of information (Page 15)
Availability of information

4

4.1 Projects

4.1.1 Definition

Project

- COMOS project

A COMOS project is the topmost form of segmentation of data within COMOS. Information can only be input, viewed or edited in COMOS once you have selected a COMOS project.

As a user, you probably know the word "project" in another context.

- Working project

A working project is, according to DIN 69901, a plan by which a defined goal is to be reached within a defined period of time (a defined starting point and a defined end point), and which is primarily characterized by the fact that it is a one-off plan.

Most COMOS users also realize a working project exactly within a COMOS project. In such cases the COMOS project is thus identical to the working project. This is also the reason why we simply refer to the "project" in the standard COMOS shipment.

The operator view

There are also COMOS users who want to organize their working projects independently of the COMOS project. Such users may have multiple working projects within a COMOS project.

Terminology used in this documentation

Only the term "project" is used in the following. But in all cases this means a COMOS project.
### 4.1.2 Project types

#### Overview

The following table describes the various project types:

<table>
<thead>
<tr>
<th>Project type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Engineering&quot;</td>
<td>The engineering project contains all information that is input by the user during the concrete implementation of an engineering task. The day to day work is done here. Engineering projects are exclusive. The information contained in it is not visible or even available in any other project. All engineering projects have an equal ranking, meaning that there is no further subdivision within the engineering projects.</td>
</tr>
<tr>
<td>&quot;Base objects&quot;</td>
<td>This is where general templates for your engineering are stored. The base objects and template documents (e.g. report templates), standard tables and assembly groups. Base projects are not exclusive. Instead, they are intended to be visible and available in other projects. As a rule there is only one base project per database.</td>
</tr>
<tr>
<td>&quot;Templates&quot;</td>
<td>Here, complete COMOS projects are stored as reference projects. Usually these are completed jobs or training examples. Template projects are available in the &quot;Engineering&quot; project mode in the &quot;New&quot; context menu. When you select a template project, a complete copy is created as an engineering project. Afterwards the new engineering project and the template project are not attached to each other anymore. If you only want to use part of the template project, use cross-project copying.</td>
</tr>
<tr>
<td>&quot;System&quot;</td>
<td>The system project is used to control COMOS. This project is only relevant for system administrators. As a user, you will not come into contact with this project.</td>
</tr>
</tbody>
</table>

#### 4.1.3 Use of projects

The projects have been specified as a rule for you as the user. In almost all cases, there are one or more engineering projects in which you work exclusively.
4.2 Working layers

4.2.1 Definition

Working layer

All information of a project is displayed in a segmented way, both in terms of the hierarchy and states. The released area is the root of all working layers.

This definition is so complex that it is explained in the following based on its individual constituent parts:

Project relation of the working layers

You can only create working layers within projects. Working layers relate only to this project. Also, they are only visible and available there. Thus a project does not contain any working layers in its basic state but only the "released area".

The released area

There is little point talking about a released area as long as there are no working layers. Nonetheless, it is there: The released area is what there is prior to all working layers and what remains once you delete all working layers. The released area is the root of all working layers. Information is handled differently in the released area compared to the working layers.

Example: Information can be physically deleted in the released area. In contrast, information is never really deleted in the working layers, with few exceptions; it is just made unusable ("soft deleted"). You find more information on this topic in the "Basic Operation" manual, keyword "soft deleted".

Segmentation

Initially the working layer is completely empty from a data point of view. If you create a new working layer and immediately export it, the result is empty. A working layer is not a copy; it is the possibility to amend, delete and edit data without directly changing the original. All data are copied in a copy – even data you have not edited. In a working layer, only the changed information is copied and new information that had been added is also available there. In this case, we are only dealing with a copy in a broader sense, because the data are modified at the time of copying. The data are copied in because they have been modified.

This is why we refer to the data as "covered-up information" instead of "copied information".
Hierarchical display

Although a working layer is initially completely empty from a data point of view, nonetheless the user still sees information. The information is "transparent". The working layer displays more than just the new information and the information that was checked in. Exactly which information the user sees depends on the tree structure of the working layers:

- The information of superordinated working layers is visible.
- The information of parallel or subordinate working layers is invisible.

Summary of display and segmentation

You need to take into consideration this difference between objects that are only displayed (transparent) and objects that are actually checked into the working layer, primarily when copying or exporting (working layers).

Status-related display

All information gets a label to display the relation to the previous working layer: For example, new, changed or deleted.

4.2.2 Use

Working layers are relatively complex by comparison with projects. The working layer technique provides a variety of commands. See also section Working layers (Page 25).

4.3 Coming up next

The first steps for you as a user are simple. Your administrator designates the database and the project you have to open.

See also

Opening the database and project (Page 19)
Opening the database and project

5.1 Selecting a database

Call

In the menu bar, click on the button.

"Open database" window

- Line 1: Select the database type here.
  
  Your administrator can tell you which database type is used in your company. The basic COMOS version is shipped with an Access database.

  If you want to work with Access, keep the default setting at "Microsoft Jet".

- Line 2: Select a specific database type here.
  - "Microsoft Jet" option: The "..." button opens a list of files from which you can select an MDB file. You can find a sample database on the CD.
  - "Oracle" or "SQL Server" option: Select an instance:
Opening the database and project

5.2 Logging into the database

Definition of "Instance"

Oracle and SQL-Server are more complex than Access. While you can open Access by clicking on an "mdb" file type, your administrator needs to specifically configure the access to Oracle and SQL Server.

You as a user simply select an instance. If you select "Instance 1" instead of "Preselection", you select a different database. Your administrator will tell you which instance you must use. If your administrator enters a description for an instance, another text is shown instead of "Instance 1".

5.2 Logging into the database

"User name" field

This field shows the user name you have used to log into the company network when your PC starts:

Click the "Open" button to confirm and to work with the rights assigned to you.

You cannot enter free text in the "User name" field. This technique prevents input errors. It is not possible for a colleague to log in to COMOS with his name on a PC where you are also logged in.

Nonetheless, there are additional forms of access to COMOS. Right-click on the "User name" field:
The following table describes the commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Universal access&quot;</td>
<td>This command enters &quot;@SETUP&quot; as the user in the &quot;User name&quot; field. While the other two commands use another name on each PC, you can use this universal form of access on all PCs and log into COMOS as &quot;@SETUP&quot;. The administrator determines the rights of the &quot;@ SETUP&quot; user in the rights management. You find additional information on this topic in the &quot;Rights&quot; manual. In the COMOS-DB, a &quot;@SETUP&quot; user is created in the user management. The user has administrator rights for this sample database. If you log in using this account, you can try the various options. Obviously, this only applies as long as the administrator rights have not been revoked from the &quot;@SETUP&quot; user in the COMOS-DB. If this case, contact your administrator.</td>
</tr>
<tr>
<td>&quot;Default access&quot;</td>
<td>Enters the user name with which you logged into the PC.</td>
</tr>
<tr>
<td>&quot;Alternative access&quot;</td>
<td>If this command is selected, the ending &quot;.2&quot; is appended to the user name. This means that in COMOS each user has a second user name available and rights can be transferred to it independently.</td>
</tr>
</tbody>
</table>

**Location information**

Click the "Extended" button to open the location information.

- "Time zone" field
  This information is taken from the operating system. COMOS uses this information to reconcile PCs that access the same database from different time zones.
- "Site" field
  You can enter a personal comment here. For example, this information is also taken into consideration in the case of electronic signatures.
5.3 Select a project

Call

To open the "Open project" tab, click the button.

"Open project" tab

A database can contain one or more projects, but you can only open one project at a time. As long as there are no working layers, the "Open project" tab looks like the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Description 2</th>
<th>Description 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMOS_AD</td>
<td>Engineering example</td>
<td>Automation Designer</td>
<td></td>
</tr>
<tr>
<td>COMOS_ET</td>
<td>Electricals</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can individually configure the display. See also section Object browser (Page 105).

Exactly which projects you can see in the list primarily depends on the rights that have been allocated to you.

To open a project, double-click on the desired project.

Project selection

A list of all projects opened since logging in is offered above the Navigator:

Each time you change the database, the list is cleared and rebuilt. The in the list displayed projects are not open. The list is only used to provide quick access.
5.4 Quicklaunch

Automatic creation of a working environment

To activate a direct start, click on the "View > Quick launch" menu.

If quick launch is enabled, at the next start COMOS automatically tries to restore the working environment in effect the last time the program was closed.

5.5 Coming up next

In most cases, you as a user do not only have to open a project, but also a working layer.

See also

Working layers (Page 25)
Opening the database and project

5.5 Coming up next
Working layers

6.1 Working layer selection

6.1.1 Tabs

Overview

If there are working layers, these are displayed for a selected project in the "Open project" tab. There you see two tabs:

- "Total overview"
- "List"

"Total overview" tab

This tab contains the working layers in a hierarchical display:
6.1 Working layer selection

Each working layer is represented by an icon, its name and description. The texts are colored according to the following scheme:

- **Black**: You need read rights for the working layer as a minimum.
- **Gray**: You cannot open this working layer, but there is a permitted working layer below it.
- **Invisible**: All working layers that you are not permitted to at least read and that do not have a subordinate working layer that you are permitted to read are invisible.

**Opening a working layer**

Double-click on the working layer to open it.

6.1.2 Commands in the context menu

**Properties of a working layer**

To open the "New" window, right-click on a project or a working layer in the "Total overview" tab and select the "New" command.

If you right-click on a working layer and select the "Properties" command, the same fields are displayed. The following table describes the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot;</td>
<td>Contains any given name, which must be unique.</td>
</tr>
<tr>
<td>&quot;Description&quot;</td>
<td>Contains any given description.</td>
</tr>
<tr>
<td>&quot;Base working layer&quot;</td>
<td>Contains the working layer of the connected base project.</td>
</tr>
<tr>
<td>&quot;ID&quot;</td>
<td>An automatically allocated identification number. Only even numbers are allocated, the odd numbers are always reserved for internal system purposes. The range of numbers goes up to 20,000, which means that you can create up to 10,000 working layers per COMOS project.</td>
</tr>
<tr>
<td>&quot;General&quot; tab</td>
<td>The administrator can create attribute tabs for working layers, which are then displayed in this tab.</td>
</tr>
</tbody>
</table>
Other commands in the context menu

- "Release to the superior layer" and "Release to the released area"

  Releases this working layer. The changes are written to the next higher working layer. The administrator determines if the released working layer is to be deleted as a result. If the to be released working layer is set to "Delete layer after release" and there is at least one subordinate working layer, you cannot delete the working layer.

  Specialty: If a release is made into the "released area", the history management function may also be available depending on the project settings.

- "Export"

  Exports the selected working layer. You find more information on this topic in the "Basic Operation" manual, keyword "Export and import".

- "Import"

  Imports a working layer. You find more information on this topic in the "Basic Operation" manual, keyword "Export and import".

6.1.3 Managing working layers

Procedure

To access working layers, proceed as follows:

1. Click on the "Extra > Working layers/history > Management" menu.
2. Click on the "Working layers" tab.

Result

The "Working layers" tab corresponds to the "Total overview" tab. Here, you can only manage working layers, not open them. The "List" tab is not available.
6.2 Using Working Layers

6.2.1 Basic working techniques

No additional interfaces required

If you have opened a working layer, you work as usual in the Navigator and reports etc. COMOS manages all working-layer specific information.

New objects

New objects in a working layer are independent of the higher-level working layers. New objects are visible in the usual way in the following working layers.

Modifying inherited objects

If a user changes an object in the working layer, the transparency is interrupted. Only now a physical copy of the object was actually made. The object is covered up or checked in.

A specialty arises if an object has been modified in a working layer and was subsequently modified likewise in the higher-level working layer. A collision occurs.

See also section Collisions (Page 29).

Deleting within working layers

- The object was checked in
  These objects cannot really be deleted. If you use the "Delete" command, the objects are only disabled, in other words, they are "soft deleted". An alternative is when a working layer is released into the released area.
- The object was newly created in the working layer
  In this case, the object is actually, physically deleted.

Deleting in the released area

Deleting in the released area is binding for the working layers. If an object in the released area is deleted, it is usually physically deleted and it is also deleted in all working layers.

Exception: The COMOS add-on function "History monitoring" is used.
6.2.2 Collisions

Collision definition

An object that has been checked into the working layer is edited again in the higher-level working layer. The into the working layer checked in object is no longer based on the most up-to-date information in the higher-level working layer.

Avoid collisions since they are generally an inefficient way of working. A collision means that the information is inconsistent and that unnecessary or incorrect inputs have been made at one point at least.

There are only two possible ways to resolve a collision:

- Releasing the working layer
  
  In this case, the information of the original is lost.

- Restoring on the object
  
  In this case the changes in the current working layer are lost.

See also section Working layer display (Page 29).

6.2.3 Release

Principle

The changes and the new objects are written to the next higher working layer. Deleted objects are also regarded as changes. You can never release a working layer that contains subordinate working layers.

Depending on the settings made by the administrator, either the working layer is deleted when it is released or else it remains as a backup that cannot be changed.

Objects can also be finally and definitively deleted by a release into the released area.

Specialty: If a release is made into the released area, the COMOS add-on function "History monitoring" can be used. You find additional information on this topic in the "Basic Operation" manual, keyword: "History / History monitoring".

6.3 Working layer display

Working layer display

To open the working layer view, right-click in the Navigator and select the "Working layer view" command.

The working layer view displays changes in the working layer.

The working layer view can only be enabled when you are within a working layer. The legend determines the colors in which the object are displayed in the working layer view.
6.3 Working layer display

Legend

You call the legend via the "Legend" command in the context menu of the Navigator.
Some objects have a considerably extended status display in the "Object status" dialog window. See also section Object status (Page 30).

Restore

The "Restore" command is only offered if the following requirements are met:

- The Navigator is in the working layers view
- An object that had been checked in is selected

The current user is a WO administrator. You find additional information on this topic in the "COMOS Administration" manual, keyword: "WO Administrator".

Effect: All changes are discarded and the corresponding information is read again from the original.

6.3.1 Object status

Overview

To open the object status, click the "Extra > Working layers/History > Object status" menu.

This tab displays all important information for an individual object with respect to working layers. When you open the object status, the currently in the Navigator selected object is evaluated. You can use drag&drop to evaluate another object.

You find more information on this topic in the "Basic Operation" manual, keyword "Object status".
6.4 Coming up next

The Navigator immediately becomes noticeable as soon as a project and a working layer have been opened. The Navigator is used to display objects and to make them available. Since the term object may be unfamiliar and since it is also necessary to introduce a number of other terms that have specific meanings within COMOS, the next section deals with the terms and definitions.

See also

- Definition of the term "object" (Page 33)
- COMOS basic operation (Page 39)
- Navigator (Page 51)
Working layers

6.4 Coming up next
Definition of the term "object"

7.1 Constituent parts of objects in COMOS

7.1.1 The basic idea of an object

Object

An object encapsulates information. An object has properties and functions, that is, characteristics or calculated information.

If you move, copy or otherwise change the object in some other way, the contents always remain intact and consistent.

In this general sense, there are also COMOS objects that you never get to see, because these special COMOS objects do not have a visible interface.

As a normal user, you are only interested in objects that are visible in COMOS. The following only refers to these objects.

You find more information on the concept of objects in the "COMOS_dll" class documentation.

7.1.2 Display of objects in COMOS

7.1.2.1 Icons

Overview

Each object has precisely one icon, which is always used when the object is displayed in the Navigator or in lists and properties.

Of course, different objects can all have the same common icon. Exactly which icon the objects have is specified in the base data. The icon is fixed and cannot be changed within the engineering data.
7.1 Constituent parts of objects in COMOS

7.1.2.2 Symbols

Definition

Symbols represent an object on a report as precisely as possible. For that reason symbols can be as complex as you wish. For example, a symbol can contain texts, diagrams and cross-references. Thus, for example, the symbols for a motor and a valve could look like the following:

An object can have any desired number of symbols, which automatically react to the specific working situation. A valve in the COMOS-DB, for example, has a symbol for the "Detail EE" drawing type, another symbol for the "P&ID" drawing type, and further symbols for standards, such as ISO and ANSI.

The symbols of an object are specified in the base object. If you use an engineering object, the symbols are there and automatically adapt to the environment.

7.1.2.3 Name, label and text

Within COMOS, objects have a name and often also a description and a label. All these details affect which text is assigned to an object.

An object can therefore have different texts in different interfaces. An object can have a different text in the Navigator as opposed to on a report and once again have a completely different text within bulk processing. In many cases, you yourself can determine the text the objects have or the text assigned to the objects.
Definition of the term "object"

7.1 Constituent parts of objects in COMOS

Navigator text

The Navigator text is precisely the string that you see in the Navigator:

```
- SPS  Control system
- SS  Control voltage
- ENA.001 Connection list for unit SS » .@NameSystem
- K1  Auxiliary contactor » +R1.S1
- K2  Auxiliary contactor » +R1.S1
- K3  Auxiliary contactor » +R1.S1
- FSS.001 Circuit diagram IEC
- PSS.L001 Sign list for unit SS » .@NameSystem.PP.PP
- S1  Emergency off » +R1.S2
- S2  Control voltage OFF » +R1.S2
- S3  Control voltage ON » +R1.S2
- S4  CHECK LIGHTS » +R1.S2
```

The Navigator text is a calculated result from various texts.

One of the most important changes concerns the relationship of name and label. If a label is entered, the name disappears in the Navigator and is replaced by the label.

There is another change regarding references. In certain situations, a double arrow ">>" appears, followed by a text that describes the referenced object.

Symbol text

The symbol controls which text objects are created on a report. Ask your administrator about this subject.

7.1.2.4 Identifying objects

Uniqueness

Neither the icon nor the visible text of an object needs to be unique.

To uniquely identify an object, open the properties of an object and check the name there. You can also navigate to the location of the object. See also section General data area (Page 63) and section Toolbar (Page 62).

The name of an object along with its location in COMOS is unique.

7.1.3 The properties of an object

Overview

You open an object with a double-click. When you open an object, you see the properties. You can thus see the full description in the properties, the data of an object. See also section Properties of an object (Page 61).
7.2 Subdivision of objects

7.2.1 System types of objects

All objects in COMOS are divided into system types. Objects with the same system type often have similar properties. Some of the important system types are explained below. The list is not complete. You find more information on this topic in the "Properties" manual.

Base objects

Base objects are general templates. Information is prepared in the base objects, for example, labels, fields, connectors, symbols, attributes.

Engineering objects

Engineering objects are the results of your work. Engineering objects are the concrete parts of or concrete information on your unit. Engineering objects are derived from base objects and inherit all information of the base object.

The following applies:

- A base object can serve as a template for any number of engineering objects. Each engineering object is based on one base object only.
- In contrast to normal templates, which you probably know from MS Office, the connection between the base object and the engineering object is dynamic. If your administrator changes a template in the base object, this change usually also takes effect in the engineering objects that are derived from this base object. In COMOS, this mechanism is called inheritance.
- The inheritance from the base objects to the engineering objects can be interrupted, for example, by entering your own values in the engineering object. If the administrator changes the templates, inheritance has no effect.

Attributes

Base objects and engineering objects contain attributes. These attributes are in turn objects themselves. This is a great help for your administrator but is virtually irrelevant for normal users. The attributes have already been defined beforehand and all you have to do is to use them.

Documents

Documents contain text and drawing information. COMOS has own document types, interactive reports and evaluating reports. In addition, COMOS can also work with numerous third-party formats.

Documents generally relate to engineering objects. A report is usually based on numerous engineering objects.
7.2.2 Object classes

Definition

Classes are a further subdivision that only exist for engineering objects. Typical classes are "Unit", "Location" and "Device", for example. The base object controls the class of an engineering object. You cannot change the class on the engineering side. Among other things, these classes offer the advantage that it is easier to search, classify and recognize objects.

7.2.3 Document types

Definition

There are no classes but instead types in the case of documents. The most important document types are "Evaluation Report" and "Interactive Report". Other types are Word, Excel, PowerPoint, Conval and AutoCAD, for example. You can create, use and open all of these document types in COMOS.

7.3 Coming up next

Up to now you got acquainted to a lot of terms in relation to base objects and engineering objects.

You encounter the system types and classes in the Navigator right from the start when you use COMOS. The "Units", "Locations", "Documents" and "Base objects" tabs are displayed there.

The "Units" tab, for example, is used with engineering objects of the "Unit" class. This does not mean, however, that this tab only contains such objects. However, engineering objects of the "Unit" class are preferred there. An engineering object of the "Unit" class must be created as the topmost object. Similarly, the topmost object of the "Locations" tab must be a location.

See also

- COMOS basic operation (Page 39)
- Navigator (Page 51)
Definition of the term "object"

7.3 Coming up next
8.1 Basic terms

Tabs

Tabs are windows that are staggered behind one another.

Tab header

The tab header indicates that a tab is available. If you click on a tab header, the tab is brought to the foreground. The tab shown in the figure above has the following header:
Frames

Tabs are grouped together in a frame. However, this frame is usually invisible:

Changing the frame size

You can change the size of the frame.

Docking indicators

See also section Changing the tab order (Page 43).
8.2 The interface

Overview

① Menu bar
② Navigator
③ Toolbar
④ Detail area
⑤ Working area
⑥ Status bar

Menu bar

The menu bar contains the most important commands and interfaces in COMOS. You cannot change or adapt the menu bar within COMOS. You find more information on this topic in the "Starting COMOS" manual, keyword "Main.xml".
8.2 The interface

Navigator

The tab display is controlled via the Navigator settings:

To open the Navigator settings, right-click in the Navigator and select the "Navigator Settings" command.

In the Navigator, you see a selection list of the projects that are to be edited in this session.

You also see a list in the Navigator for selecting the open working layers.

If you reduce the size of the Navigator horizontally, the caption of the tabs is automatically hidden:

When you hold the mouse pointer over the header, the hidden text is displayed as a tooltip:

Toolbar

Here, a link is provided for direct access to frequently used commands of the menu bar. You cannot change or adapt the toolbar within COMOS.
Detail area

The detail area is located at the lower left, below the Navigator. The detail area serves to add the "Details" tab and special windows.

You can also control the "Details" tab via the Navigator settings.

Working area

Documents and properties are first opened in the working area and then staggered as tabs.

Status bar

The status bar provides information relating to COMOS in general, for example, the number of unsaved objects.

Many tools in COMOS have their own status bar. The status bar also provides context dependent access to some important management tools. Right-click on the corresponding field for this.

Example: The status bar displays how many objects are unsaved. For this, right-click "Save" and select "Save" from the context menu.

8.3 Operator control

8.3.1 Changing the tab order

Procedure

To change the order of the tabs in the Navigator, proceed as follows:

1. Drag a tab header to the center of its own frame.
   The docking indicator appears.
2. Drag the header to the center of the docking indicator.
Result

The tab is inserted newly and moved to the far right.

8.3.2 Creating a new tab

You can increase the number of tabs in the Navigator as many times as required.

Closed detail window

If the "Details" tab is not open yet, a new tab is created in the detail area using drag&drop:

The detail area is opened and the tab is displayed:
Opening the detail area

If the detail area is already open, the drag&drop operation is executed in the area you have selected:

In this example, the "Performance" object is not displayed in the detail area, but a new tab is created in the Navigator:

Similarly, you can also create a new tab in the detail area.

Additional tabs in the Navigator when switching projects

When you switch to another project, the additional tabs in the Navigator remain set and display the objects from the other project.
Using the detail area

As a result, you can see any number of tabs in the detail area.

8.3.3 Moving tabs into another frame

Procedure

To move tabs into another frame, proceed as follows:

1. Drag a tab header to the center of another frame.
   
   The docking indicator appears.

2. Drag the header to the center of the docking indicator.
Result

The tab is incorporated in the destination frame.

8.3.4 Separate frames for working area and Navigators

Frames

The tabs in the Navigator and special windows are managed separately from the tabs of the properties and documents.

In the Navigator and special windows, the tab headers are located at the bottom:

In the properties and documents, the tab headers are located at the top:
Thus, the following drag&drop operation is not possible:

In return, properties and documents cannot be moved to frames where tabs in the Navigator are collected.
8.3.5 Splitting frames

Procedure

To split a frame, proceed as follows:

1. Drag the header to the to be split frame.
   A docking indicator appears.
2. Hold down the left mouse button and drag the header to one of the arrows.

Result

Two frames are available. Since the frames themselves are invisible, you can only recognize them because the tabs are now located next to each other and not on top of each other.
8.3.6 Closing tabs

Main statement
To close a tab, proceed as follows:
1. Right-click on a tab header.
2. Select the "Close" command from the context menu.

Result
As soon as the last tab of a frame is closed, the frame disappears.
9.1 Overview

Structure

The Navigator has four tabs in the footer area. The largest part of the area is occupied by the structure area with the structure tree. When the "Details" tab is active, it is displayed below:
9.2 Navigator interface

9.2.1 Tabs of the Navigator

Overview

The tabs relate to the system types or the object classes:

- "Units" tab:
  
  An engineering object of the "Unit" class must be created as the topmost object. This tab has a unit-specific view of the engineering data. You cannot create any base objects on this tab.

- "Locations" tab:
  
  An engineering object of the "Location" class must be created as the topmost object. This tab has a location-specific view of the engineering data. You cannot create any base objects on this tab.

- "Documents" tab:
  
  An engineering object of the "Document group" class must be created as the topmost object. Normally, only additional document groups or documents are created underneath that group. You cannot create any base objects on this tab. This tab also has a direct relationship to the "Documents" tab in the base project. See also section Documents (Page 123).

- "Base objects" tab:
  
  This tab is the only place where objects with the "base object" system type can be created. In addition, the tab spans across projects. Both, the base objects of the base project and base objects that were created in the current project are offered.

  The "Base objects" tab from the base project and the current "Base objects" tab are mixed together.

  See also section Structure engineering (new engineering objects) (Page 73).

"General" class

The "General" class is an exception, because objects of this class appear both on the "Units" tab as well as on the "Locations" and "Documents" tabs.
9.2.2 Commands in the context menu of the Navigator

Requirement

Ensure that no object is selected in the Navigator.

Procedure

Right-click in the Navigator to open the context menu of the Navigator.

9.2.2.1 “Navigator settings” command

This command opens the "Navigator settings" window:

“Display” control group

Controls the display of the information in the Navigator:

- "Top" option: display in the main area
- "Down" option: Display in the detail window
- "Off" option: No display

If you hide the "Details" tab, all entries displayed in the "Details" tab automatically appear in the main area.
"General" control group

The following table describes the options of the "General" control group:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Directly edit new objects&quot;</td>
<td>If you select this option, the properties of all new objects are opened. The option is also evaluated when base objects are created as engineering objects using drag&amp;drop. When the option is disabled, new objects are created with an automatically generated name.</td>
</tr>
<tr>
<td>&quot;Save automatically&quot;</td>
<td>The activated option causes objects to be saved automatically. The deactivated option causes you to manually save the objects.</td>
</tr>
<tr>
<td>&quot;Sort alphabetically&quot;</td>
<td>The activated option causes objects in the Navigator to be sorted alphabetically based on the visible text.</td>
</tr>
<tr>
<td>&quot;Sort 'Folder' objects to top&quot;</td>
<td>When this option is enabled, objects with the &quot;Folder&quot; property are displayed at the top of the tree. They are followed by objects without this property. See also section General data area (Page 63).</td>
</tr>
</tbody>
</table>

"Tabs" control group

The options toggles a tab on and off. The lowest option, for example, switches the "Details" tab on or off.

The list switches the views on or off. The views are prepared and named by the administrator. Your administrator can tell you which views are relevant. You find additional information on this topic in the "Basic Operation" manual, keyword: "Views".

9.2.2.2 "Status display" command

The objects are displayed by means of a color code. See also section Status management (Page 117).

9.2.2.3 "Working layer display mode" command

See also section Working layers (Page 25).
9.2.2.4  The "History display" command

This command is only available if the COMOS add-on function "History monitoring" is enabled. You find additional information on this topic in the "Basic Operation" manual, keyword: "History / History monitoring".

9.2.2.5  "Legend" command

Color settings

This command opens the "Color settings" window and controls the color code for the appearance of the working layer. In the "Working layer color settings" tab, you can also set a color for each working layer.

You find more information on this topic in the "Basic Operation" manual, keyword "Legend".

See also

- Basic working techniques (Page 28)
- Collisions (Page 29)
- Object status (Page 30)
9.3 Mouse operation in the Navigator

9.3.1 Selecting

You select objects, documents and attributes by highlighting them. You can perform various actions with selected objects.

**Single selection**

To select an object, click on it.

**Multiple selection**

To select several objects, click on an object. Hold down the <Ctrl> key and click on further objects.

Try the various forms of highlighting and selection to see how they work; in particular, in connection with drag&drop.

**See also**

Definition of the term "object" (Page 33)

9.3.2 Drag&Drop

**Definition**

Drag&drop is a means of moving objects together with the object information. You can use drag&drop to copy or move objects or create references and links.

Drag&drop is carried out in two steps:

1. Left-click on an icon and hold down the mouse button.

2. Drag the object while holding down the mouse button to the new location and then release the button.
The mouse pointer changes its shape while moving depending on whether the drag & drop operation is being used to create a copy or a reference.

If drag & drop is not possible, this is indicated by a crossed-out circle.

As long as you have not yet released the mouse button, you can also cancel the drag & drop operation you have begun. To do this, keep the mouse button pressed and then press the <Esc> key.

9.3.3 Double-clicking

Effects

- If you double-click on an object in the Navigator, the properties of the object are displayed.
- If you double-click on a document, it opens.

9.3.4 Functions in the context menu

Right-click to open the context menu. What is shown in the context menu depends on the context.

Important commands in the Navigator shortcut menu

The following table describes the important commands in the context menu of the Navigator:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;New&quot;</td>
<td>Predefined objects are offered here. Which objects are available depends on where the menu is called and the in the base data made preparations. See also section Structure engineering (new engineering objects) (Page 73).</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Deletes the selected object.</td>
</tr>
<tr>
<td>&quot;Cut&quot;</td>
<td>Cuts the selected object.</td>
</tr>
<tr>
<td>&quot;Copy&quot;</td>
<td>Copies the selected object.</td>
</tr>
<tr>
<td>&quot;Paste&quot;</td>
<td>Pastes a cut or copied object.</td>
</tr>
<tr>
<td>&quot;Restore&quot;</td>
<td>See also section Working layer display (Page 29).</td>
</tr>
<tr>
<td>&quot;</td>
<td>Working layers/Histories&quot;</td>
</tr>
<tr>
<td>&quot;Move&quot;</td>
<td>This command is only available if you have previously copied an object. The copied object is removed from the old location and inserted at the new location.</td>
</tr>
</tbody>
</table>
9.3 Mouse operation in the Navigator

9.3.5 "Navigate" context menu

A very important function of the Navigator is to display the relationships of the data and to navigate to the corresponding data.

Right-click on the object to navigate. The "Navigate" command is offered in the context menu. The commands in the "Navigate..." menu vary depending on the selected object.

Navigation commands

The following table describes the commands of the "Navigate" context menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Copy structure&quot;</td>
<td>Objects can have a wide variety of relationships to other objects. This command considers an object as part of the overall design and copies not only the object itself, but also all other objects to which it is linked. The structure in which the object is embedded is thus retained.</td>
</tr>
<tr>
<td>&quot;Paste link&quot;</td>
<td>This command is only available if you have previously copied an object. A link creates an additional way of accessing an object. You can only set links within a project.</td>
</tr>
<tr>
<td>&quot;Navigate&quot;</td>
<td>See also section &quot;Navigate&quot; context menu (Page 58).</td>
</tr>
<tr>
<td>&quot;Print&quot;</td>
<td>This command is only available if one or more documents are selected. You find more information on this topic in the &quot;Basic Operation&quot; manual, keyword &quot;Printing&quot;.</td>
</tr>
<tr>
<td>&quot;Find&quot;</td>
<td>Opens the &quot;Find..&quot; window where you can search for objects. See also section Searching for objects (Page 81).</td>
</tr>
<tr>
<td>&quot;Properties&quot;</td>
<td>Open the properties of an object or document. See also section Properties of an object (Page 61).</td>
</tr>
</tbody>
</table>

The list of the here introduced navigation commands is just a small selection. Depending on the object you select for the "Navigate" command, more navigation commands appear. You find additional information in the relevant manuals.
9.4 Coming up next

The Navigator gives an overview of the existence and structure of the objects. However, if you want to edit all aspects of an individual object, you need the properties of the object.

See also

Properties of an object (Page 61)
9.4 Coming up next
Properties of an object

10.1 Structure

Overview

If you open an object, the properties of the object are displayed on a tab. These properties consist of four main areas:

1. Toolbar
2. General data
3. Tabs
4. Buttons

Configuration of the properties

The figure above describes a basic state, namely the appearance of the engineering objects, unless the administrator has arranged things otherwise. The administrator can specify whether a general area is visible. The administrator can also specify which tabs are visible. The toolbar and buttons are always visible.
Fixing properties

If the properties of an object are already open and you open another engineering object, the properties of the newly opened object are displayed. If you want to see the properties of the first object, click on the tab Reuse tab/window. The properties for another object are shown in a new tab.

Click the button "Leave tab/window open".

Closing properties

If you want to close the currently selected properties, click the middle mouse button on the tab or press the key combination <CTRL+F4>.

If you have opened the properties of multiple objects, you have various options for closing the properties. Right-click on the tab and select the following command in the shortcut menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Close&quot;</td>
<td>Closes the current tab.</td>
</tr>
<tr>
<td>&quot;Close all except for current&quot;</td>
<td>Closes all tabs except for the current one.</td>
</tr>
<tr>
<td>&quot;Close all except for fixed&quot;</td>
<td>Closes all tabs except for the fixed one.</td>
</tr>
<tr>
<td>&quot;Close all&quot;</td>
<td>Closes all tabs.</td>
</tr>
</tbody>
</table>

10.2 Toolbar

Overview

The following table describes the buttons in the toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Navigate" /></td>
<td>&quot;Navigate&quot;</td>
<td>Opens a menu with navigation commands. See also section &quot;Navigate&quot; context menu (Page 58)</td>
</tr>
<tr>
<td><img src="image" alt="Owner" /></td>
<td>&quot;Owner&quot;</td>
<td>The content of the opened properties changes. The properties of the higher-level object are displayed. The button is disabled for objects of the topmost level.</td>
</tr>
<tr>
<td><img src="image" alt="鎖" /></td>
<td>&quot;Released&quot; and &quot;Locked&quot;</td>
<td>When an object is locked, you can no longer change it. Whether or not you are permitted to lock an object depends on your rights.</td>
</tr>
</tbody>
</table>
Other buttons

The toolbar adapts itself to the circumstances and then contains additional buttons. Example: When you open tabs, additional buttons appear. The most important of these are the buttons for filtering:

If, for example, objects of various types are displayed on the "Connectors" tab, a button appears for each type. When you click a button, all connectors of this type are displayed. If a button is not clicked, all connectors of this type are no longer displayed.

See also

- General (Page 64)
- Alternative configuration of reference fields (Page 66)

10.3 General data area

Control elements

The following table describes the control elements:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot; field</td>
<td>The name is automatically generated or input.</td>
</tr>
<tr>
<td>Button</td>
<td>This button creates a new name.</td>
</tr>
<tr>
<td>&quot;Label&quot; field</td>
<td>There is an interaction between the &quot;Name&quot; and the &quot;Label&quot;. If a &quot;Label&quot; is entered, it covers the &quot;Name&quot;, for example, in the Navigator. The &quot;Name&quot; is the more important property from data system point of view. It is a mandatory field and also always unique. However, in practice the &quot;Label&quot; is often more important, since the database is classified by means of &quot;labeling systems&quot;.</td>
</tr>
<tr>
<td>&quot;Description&quot; field</td>
<td>The entry is displayed in italics as long as the description is taken from the base object. If you make a manual entry, the entry is now the own description of this object and is no longer displayed in italics.</td>
</tr>
<tr>
<td>button</td>
<td>This button appears when the engineering object is in the basic state and references to the &quot;Description&quot; can be set using drag&amp;drop. See also section General (Page 64). If the object was configured by an administrator, the button does not appear.</td>
</tr>
</tbody>
</table>
10.4 Reference fields

10.4.1 General

Display of the reference fields

No reference fields are initially visible.

If, for example, you want to allocate a component to a specific location, drag the location object onto the description in the properties:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Folder&quot; option</td>
<td>You can also declare the to be created engineering object as a folder. As a folder it serves purely organizational purposes, for example, to divide further engineering objects. Folders are not taken into consideration in the overall labeling of an object. This applies in particular if a labeling system already exists. The &quot;Folder&quot; option can already be activated in the base object. If this is the case, you can no longer disable the option in the engineering view.</td>
</tr>
<tr>
<td>&quot;Implementation&quot; field</td>
<td>Displays implementations. See also section Examples of references (Page 85).</td>
</tr>
</tbody>
</table>
A reference field appears, in which the location is entered.

A navigation menu appears once you right-click in the reference field. You can find a practical example for working with references in the "Assigning engineering objects (reference) (Page 78)" section.

**Delete reference**

To delete a reference, click on the "Delete reference" button next to the field.

### 10.4.2 Examples of references

#### Overview

The most important links are:

<table>
<thead>
<tr>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias reference</td>
<td>The &quot;Alias&quot; reference field appears automatically when an alias branch has been defined in the unit or location world. Drag the object from the alias branch into the field from which the alias label should be entered.</td>
</tr>
<tr>
<td>Unit and location pointer</td>
<td>You can set a unit or a location as a reference at each engineering object.</td>
</tr>
<tr>
<td>Implementation reference</td>
<td>If an engineering object is based on a base object with the &quot;Request&quot; property, the engineering object automatically has an &quot;implementation&quot; field. Once the implementation reference is made visible in this way, you can set a new engineering object as the implementation using drag&amp;drop.</td>
</tr>
</tbody>
</table>
10.4.3 Alternative configuration of reference fields

"General" tab

The administrator can configure the new properties. For example, the objects can be prepared in such a way that all references are grouped in the "General" tab. The references then appear on the "General" tab and not at the very top of the general area of the properties:

In this case, use the visible reference fields. You can no longer drag a reference into the "Description" field.

10.5 Tabs of the engineering object

General

You perform your daily work on the tabs. This is where you can find all defaults of the base object, which you then only have to fill in.

See also

- Setting the base object (Page 77)
- Editing engineering data (Page 87)
10.6 Buttons

Overview

The following table describes the buttons in the properties of an object:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;OK&quot;</td>
<td>The changes are saved and the properties are closed.</td>
</tr>
<tr>
<td>&quot;Cancel&quot;</td>
<td>The properties are closed and all unsaved changes are discarded.</td>
</tr>
<tr>
<td>&quot;Apply&quot;</td>
<td>All changes are saved. The properties remain open.</td>
</tr>
</tbody>
</table>

Using input commands

When you close the properties with the "OK" or "Cancel" button, all objects changed within the properties, such as connectors and elements, are registered:

- "Cancel" button:
  Deleted objects are restored.
- "OK" or "Apply" button:
  Deleted objects are permanently deleted.

10.7 Coming up next

The "Base objects" tab in the Navigator is an example of a simple and intuitive access to the templates. The base objects that you require most often can be saved in a separate bar.

See also

Base objects through the symbol bar (Page 69)
11 Base objects through the symbol bar

11.1 Symbol bar

Definition

Base objects can be made available in a custom symbol bar. You do not need to search for specific base objects in the "Base data" tab but instead have direct access to these objects in the symbol bar.

The icon of the base object itself is displayed in the symbol bar. If you click on the icon and drag it onto a document, you place the object.

See also

Display of objects in COMOS (Page 33)

11.2 Creating a symbol bar

Procedure

To create a symbol bar, proceed as follows:

1. Open the desired report.
2. Right-click on the gray bar at the far right.
3. Select the "Create symbol bar" command from the context menu.

The "Edit toolbar" window opens.
4. To create a new symbol bar, enter a name for the new symbol bar in the bottom empty cell of the "Symbol bars" column.

5. Drag & drop base objects from the Navigator into the "Symbols" column.
Base objects through the symbol bar
11.2 Creating a symbol bar

The base objects appear in the "Symbols" column.

![Symbol bar GUI](image)

Result

The newly created symbol bars are always added by default on the right. To move the new symbol bars, click on the edge of the symbol bar and drag it to a new location.

If you drag a symbol bar from the bottom to the top, the symbol bars located above are moved together. You can expand the hidden entries using the small arrow. Furthermore, the order of the symbol bars change.

Alternative procedure for setting a reference

You can drag a report template that already has a document-specific symbol bar into the "Reference" field of the symbol bar window. You cannot edit the symbol bar any further at this point.
11.3 Using a symbol bar in the report

Procedure

To use a symbol bar in the report, proceed as follows:

1. Open the report.
2. Click on an icon in the symbol bar.
   The symbol of the object is shown at the mouse pointer.
3. Click on the report again as often as necessary to place the object.
   With each click, an object is created on the report and also in the Navigator.
4. To complete the process, press the <Esc> key or click on the "Identify" button.

11.4 Coming up next

You can now create more engineering objects. The daily work can begin.

See also

Structure engineering (new engineering objects) (Page 73)
Structure engineering (new engineering objects)

12.1 The idea behind structure engineering

Grouping

Objects are sorted and grouped in COMOS.

Example

If there are three units in a room, you can see this at a glance.
When the three units are located in the room, this is displayed in COMOS as three units below the same “Room” object in the structure tree.

12.2 Possibility 1: Free structure engineering

12.2.1 First level: Creating a new unit / new location

Procedure

To define a unit or location in the first stage of the project, proceed as follows:
1. Click on the "Units" tab or "Locations" tab in the Navigator.
2. Right-click on the project.
3. Select the "New > New unit" command from the context menu or "New > New location".
Drag&drop is not allowed directly underneath the project root. You therefore have to create the first object via the context menu. Exactly what you see in the "New" menu depends on the project you open and the object selected. There is also often a "General" submenu and a number of sample objects:

For example, if a labeling system is to be used, the corresponding start objects are offered in the context menu. In the figure above, this is the entry "200 Location acc. to kks", meaning that it involves a power station labeling system. See also section Possibility 2: Labelling system (Page 76).

The "New unit" and "New location" commands are not always available. In particular, these two commands are often not available in labeling systems to prevent you from deviating from the scheme of the labeling system. If the "Edit new objects directly" option is selected in the settings of the Navigator, the properties now open. Otherwise, open the properties by double-clicking on the new unit or new location.
You can describe the new object in more detail in the properties. Do this by filling out the general data:

- "Name" field
  Unique name
- "Description" field
  A desired single line text
- "Label" field
  Any desired label

Folder

You can label the newly to be created engineering object as a folder. As a folder it serves purely organizational purposes, for example, to divide further engineering objects. Objects with the "Folder" option are hidden in some evaluations. Example: If you deeply nest a unit structure, you can declare the units in the middle as "folders". These levels will not appear in the FullName of an object.

Recommendation

Do not declare the top unit as a folder.

12.2.2 Further levels in free structure engineering

On all following levels you always have the change to create a unit, a location, a device or a document.

Procedure

To create a new object, proceed as follows:

1. Right-click in the Navigator on the object below which you want to create a new object.
2. Select the "New" command:
   If a labeling system or other prepared objects are available, select the "New > General" command and the desired object.

See also section General objects (Page 77).
12.3 Possibility 2: Labelling system

Definition of labeling system

A labeling system is a structure template. A labeling system relieves you of the work associated with structure planning.

1. Open a sample project from the COMOS-DB.
2. Right-click on the project.
3. Select the "New" command in the context menu.

If labeling systems are available, they are listed as shown at the bottom of the shortcut menu separated by a dash:

```
COMOS_KKS Power plant acc. KKS standard
Released area linked to Released area
```

4. Click on one of the entries and they are added to the labeling system.

From this point on, only those objects that are predefined in the labeling system are offered in the context menu at all levels below.

A labeling system is prepared beforehand by an administrator. In the engineering view, you simply use the labeling systems.

In most labeling systems, you also have the option to create a general object. See also section General objects (Page 77).
12.4 General objects

12.4.1 Creation

General objects

General objects are empty. You use templates for the "New unit" and "New location" commands. The settings options are limited. On the other hand, a general object can become anything – also a new unit or a new location.

Procedure

To create a general object, proceed as follows:

1. Select an object in the Navigator.
2. Right-click on the object.
3. From the context menu, select the "New > General > New Object" command.
   The properties of the object open.
4. If the properties do not open automatically, double-click on the newly created object.
5. Enter the general data in the properties.
6. Set a base object.
   A base object is the template for engineering objects. If you do not set a base object, you cannot work with an engineering object.

See also

Setting the base object (Page 77)

12.4.2 Setting the base object

Requirement

You have created a general object.
Structure engineering (new engineering objects)

12.5 Assigning engineering objects (reference)

Procedure

To set a base object, proceed as follows:
1. In the properties, click on the "General" tab.
2. Search for the required template in the "Base objects" tab of the Navigator.
3. Drag&drop the base object from the Navigator into the "Base object" field of the opened properties.

Result

The contents of the properties tab changes. From now on the settings from the base object are available in the engineering object. You can set a new base object at any time. You can find out how to find a specific base object in section Searching for objects (Page 81).

12.5 Assigning engineering objects (reference)

Previously, it was explained that a logical assignment can be recognized by the location of the object in the structure tree.

If you want to provide objects with additional structural information, however, you can use references, for example, a reference to a location. See also section Reference fields (Page 64).

Procedure

To set a reference, proceed as follows:
1. Open the properties.
2. To set a reference to a location, click on the "Locations" tab in the Navigator.
3. Drag&drop a location from the properties into the "Description" field:
Result

The reference appears in the properties of the object and in the Navigator.

You cannot assign a unit reference to an object that is created on the "Units" tab. You cannot assign a location reference to an object that is created on the "Locations" tab.

12.6 Preparations

Automatisms

When you create engineering objects, it is possible that certain information and interrelationships are already available. In such a case your administrator has already preprepared the base objects accordingly.

12.7 Mixing units and locations

Device tag

The structure engineering has, among other things, the purpose of illustrating the device tags through the object structure. Since a device tag is required to be unique, COMOS defines mechanisms that force the allocation of a unique name. However, there are various definitions as to exactly when a device tag is regarded as unique.

One of these definitions states that both the unit and the location are used to determine uniqueness. The uniqueness is made up of the device tag from the entire string of the unit, location and device. On the basis of this definition, for example, the labels =A1+O1-B1 and =A2+O1-B1 are unique and hence permissible.

Within the usual data structure of COMOS these labels would be recognized as incorrect, a warning message would pop up, and the tags would be corrected. Device B1 may only exist once underneath O1. In order to allow labels of this kind within projects, COMOS permits a data structure in which the locations are created underneath the units.

Only objects with the "Unit" class may be created at the top level of the "Units" tab and only objects with the "Location" class may be created at the top level of the "Location" tab. However, it is permissible to mix units and locations on all the subsequent (lower) levels.

In the simplest case, you do this by dragging the base object of a location onto a unit, thereby creating the location below the unit. These mixed structures are then queried and are output in the reports through the use of suitable text functions.
12.8 Coming up next

When you create a data structure, the question arises as how to find the created objects again. When you create a general engineering object, you need a matching base object. You can also search the base objects.

See also

[Search for objects](Page 81)
13.1 Searching for engineering objects

13.1.1 Opening a dialog window

Procedure

To open the "Find..." window, proceed as follows:

1. Right-click on an engineering object in the Navigator.
2. Select the "Find" command in the context menu.

When you click on the project root, the search may take a long time because you search through an entire project.

13.1.2 "Search" tab

Overview

The following table describes the control elements of the "Search" tab:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Search below&quot; field</td>
<td>This shows the object you have selected in the Navigator. You can set a new object using drag&amp;drop. A navigation menu is made available if you right-click in the field.</td>
</tr>
<tr>
<td>&quot;Contained text&quot; field</td>
<td>Enter the to be found text here.</td>
</tr>
<tr>
<td>&quot;Start&quot; button</td>
<td>Starts the search</td>
</tr>
<tr>
<td>&quot;Relative name&quot; column</td>
<td>The relative name is a calculated name and serves to identify an object. The relative name has no effect at all on whether or not an object appears in the results. For example, the relative name of attributes always includes the tab in which the attribute is located. In the case of connectors, the owner is taken into consideration.</td>
</tr>
<tr>
<td>&quot;Description&quot; column</td>
<td>Outputs the &quot;Description&quot; field of the object.</td>
</tr>
<tr>
<td>&quot;Text&quot; column</td>
<td>The exact Navigator text is shown here. You can tell from this text why an object appears in the results set.</td>
</tr>
</tbody>
</table>

Further editing the search results

This tab contains an object browser in which you can sort and filter as required. See also section Object browser (Page 105).
13.1.3 "Options" tab

13.1.3.1 Database-based search

Recommended for beginners.

Use the database-based search as long as you have no experience with this tool.

Upper and lower cases are always taken into account with this search type.

Supported objects

If you disable one of the listed system types here, the corresponding objects are no longer displayed in the results list. The search is correspondingly faster when fewer options are enabled.

Supported properties

If you disable a property here, the number of hits is likewise reduced. The search is correspondingly faster when fewer options are enabled.

The properties correspond to the following fields in the properties of the objects:

<table>
<thead>
<tr>
<th>Option on the &quot;Options&quot; tab</th>
<th>Field in the properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Name&quot;</td>
<td>&quot;Name&quot;</td>
</tr>
<tr>
<td>&quot;Label&quot;</td>
<td>&quot;Label&quot;</td>
</tr>
<tr>
<td>&quot;Description&quot;</td>
<td>&quot;Description&quot;</td>
</tr>
<tr>
<td>&quot;Value&quot;</td>
<td>For attributes only: &quot;Value&quot;</td>
</tr>
</tbody>
</table>
13.1.3.2 Search in the Navigator text

General

The Navigator text is precisely the string that you see in the Navigator. This string can be influenced in a variety of ways. See also section Name, label and text (Page 34).

Hence, if you are searching for the name of an object but the name cannot be seen in the Navigator because a label has been entered, the object will not be found by this type of search.

Control elements

The following table describes the control elements of the search in the Navigator text:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Case sensitive&quot; option</td>
<td>Considers case sensitivity</td>
</tr>
<tr>
<td>&quot;With pattern matching&quot; option</td>
<td>If you enable this option, you can also enter wildcards in the &quot;Containing text&quot; field of the &quot;Search&quot; tab.</td>
</tr>
<tr>
<td>Button</td>
<td>If you click this button, a message window opens. Here you see which wildcards are allowed in the search. See also section Examples for searching with placeholders (Page 83).</td>
</tr>
</tbody>
</table>

13.1.4 Examples for searching with placeholders

Overview

```
Search entries

*Wildcards*

- ?  - Any kind of single character.
- *  - No or more characters.
- #  - Any single number (0 - 9).
- [Character List]  - Any kind of single character in the character list.
- [Character list]  - Any kind of single character, which is not in the character list.

Character area (like [A-Z]) possible instead of character list

*Valid separators*

- ,  - Comma.
- ;  - Semicolon.
```
There are two reasons for using wildcards in the search:

- You do not know the exact spelling.
- You want to search for similar objects and these similar objects also have similar names.

**Controlling the amount found in a search**

Consider that a search also covers all lower levels. Starting from the base object - not only the visible objects of the first level are searches, but also all objects below.

To reduce the search set, open the settings of the Navigator and disable all unnecessary system types in the "Display" list:

When you select the search in the Navigator text in the search window, following result will occur:

When an object is not displayed in the Navigator, no Navigator text is created for this object and it is therefore ignored with the "Search in Navigator text" search method.

**The character list**

The help for search entry describes this as follows:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Any kind of single character.</td>
</tr>
<tr>
<td>*</td>
<td>No or more characters.</td>
</tr>
<tr>
<td>[Character list]</td>
<td>Any kind of single character in the character list.</td>
</tr>
</tbody>
</table>

Delineate each character with square brackets. Only the relevant first character is evaluated.

**Example**

Search entry "[H1]" thus finds all objects starting with "H", since the second character "1" is ignored.

Enter the "[H][4]" search text in order to only find the "H4 Ready" object.

**The character area**

Note that ASCII sorting is used in the character area. This applies in particular if the "Case sensitive" option is enabled.

- "Case sensitive" is disabled:
  
  "[A-d]" searches for the following letters: A, a, B, b, C, c, D, d.

- "Case sensitive" is enabled:
  
  "[A-d]" searches for the following letters: All upper case letters (i.e., A to Z) and the special characters \[\] ^ _ ` and the lower case letters a, b, c, d.
Searching for objects
13.1 Searching for engineering objects

Any desired single character

If you use only "?" as the wildcard for a given single character, you need to know the exact number of characters in the Navigator text.

Example: The "H4 Ready" object has two characters for the name "H4" and six characters for the description "Ready". However, when you search for this in the Navigator text, you also have to consider the number of spaces between "H4" and "Ready". There are three spaces in the starting state.

In order to find the "H4 Ready" object when you know the initial letter and otherwise only use question marks, the correct search text is as follows:

![H]?????????

However, there do not necessarily have to be three spaces between the name and description. Therefore, combine the "?" wildcard with the "*" wildcard.

No or multiple characters

Thus "*" can stand for no or more characters. The * expression therefore finds all objects. The "[A]*" expression finds all objects that start with "A".

Excluding characters

You can use [!] to exclude specific characters. If you enter [!B]* and the "Case sensitive" option is enabled, a search is made for all objects that do not start with "B".

It is not possible to exclude a range of characters.

If you write multiple character exclusions one after another, you get a hierarchical division of the expressions. Thus [!A][!B]* does not exclude "A" and "B" as the initial letters. Instead, the above expression searches for all objects that do not have "A" as the first letter and do not have "B" as the second letter.

The delimiter

The delimiter can only increase and never decrease the result set.

[A]*;[B]* searches for all objects that either have an "A" or a "B" as first letter.

However, the search text [!A]*;[!B]* searches for all objects, for example. Reason: The first [!A]* expression searches for all objects except those that begin with "A". The second expression adds more objects to the resulting object set by searching for objects that do not begin with "B" - as a result, all objects will be found.
13.2 Object queries

General

The introduced search function in no way exhausts the capabilities of COMOS. COMOS features a tool called object query that allows you to perform even the most complex search operations.

See also

Object queries (Page 103)

13.3 Coming up next

You have now created a first data structure. The objects that have been created should now be filled with engineering data. You now want to enter specific values, such as sizes, quantities, etc., or you want to link connectors.

You can carry out all of these tasks in the tabs of the properties.
14.1 Basic state of the properties

General

The properties include information from the "General data" area and the tabs. See also section Properties of an object (Page 61).

Up until now, you have worked with the "General data", since you needed it for the structure engineering, and also with the "General" tab that you required for new "General objects".

Which of the tabs you see depends on the configuration of your engineering objects. Only the most important tabs are presented here. Besides that, there are many other specialized tabs.

14.2 "General" tab

You only need the "General" tab when you create new, free engineering objects. See also section Setting the base object (Page 77).

In addition to the drag&drop field for the base object, you also see the "Set reference" button.

Base object:  

You do not need this button as a beginner. You find more information on this topic in the "Electrical Engineering" manual, keyword "Allocating device requests to manufacturer devices".

A configured variant of the "General" tab

Objects are often prepared in such a way that all references are grouped on the "General" tab. The references are then on the "General" tab and not at the very top in the general area of the properties.
14.3 "Attributes" tab

14.3.1 Purpose

General

You enter texts, numbers, units, etc. on the "Attributes" tab. The appearance of the "Attributes" tab is fully controlled by the specifications of the base object. The "Attributes" tab appears differently if you assign another base object to the engineering object.

The "Attributes" tab is divided into additional tabs. These subordinate tabs are attributes tab. However, the manual often also uses the term tab for these attribute tabs. In the following figure e.g. the following tabs are attribute tabs:

- "Technical data"
- "Assembly data" etc.

To be able to reproduce the following examples, you need to create two similar engineering objects, for example:

"@01 Material > PID Piping and Instrumentation > Catalog P&ID > Pipes > 01 Pipe"
14.3.2 Entering values manually

Procedure

To open the "Attributes" tab, proceed as follows:

1. Enter the required information.
2. Click on the "OK" or "Apply" button to confirm your entries:

Note the following:

- If the entries are not confirmed with "OK" or "Apply", the information may be lost in the case of inadvertent operation.
- After the entries are confirmed, the "Cancel" button has no effect.
- The "Apply" button is enabled only after the first change.
- If you select another unit, the previous entries are automatically converted:
Colors

The following tables describes the colors of the values:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>No change in the last 48 hours.</td>
</tr>
<tr>
<td>Blue</td>
<td>Own changes:</td>
</tr>
<tr>
<td></td>
<td>• Light blue: Changes in the last 48 hours.</td>
</tr>
<tr>
<td></td>
<td>• Dark blue: Changes in the current session.</td>
</tr>
<tr>
<td>Red</td>
<td>Changes by another user:</td>
</tr>
<tr>
<td></td>
<td>• Light red: Changes in the last 48 hours.</td>
</tr>
<tr>
<td></td>
<td>• Dark red: Changes in the current session.</td>
</tr>
<tr>
<td>Fill color orange</td>
<td>The value does not conform with the other values and the unit. Correct the value. The orange colored filling will disappear after the correction.</td>
</tr>
</tbody>
</table>

14.3.3 Copying data manually

Commands

In many cases, data is automatically transferred from one engineering object to another. Nevertheless, there are situations where you would like to copy data manually.

Commands are made available if you right-click on the tab. Additional context menu commands follow depending on the data. Only a selection of the commands are described below.
"Copy tab data" and "Paste tab data" commands

- **Copy tab data**
  
  Copies all values and units from the attributes tab.

- **Paste tab data**
  
  This is only available when data has been copied beforehand.

Once you have copied the data, you can open the properties of another engineering object and open an attribute tab of the same name. The "Paste tab data" command is only displayed if the current attributes tab for the other engineering object has the same name as the one at which the copy operation was performed.

The "Paste tab data" command now has the effect that the names of the attributes are checked in the current attributes tab. The corresponding value and unit are transferred for each attribute whose name matches the name of the attribute from which you are copying. No new attributes are created.

The combination of "Copy tab data" and "Paste tab data" is especially useful when there are only slight differences between two engineering objects. In this case, you can import the entries of an engineering object by copying and then change only the attributes that differ.

### 14.3.4 Data flow (static links)

**Purpose**

A data flow is a fixed transfer of engineering data. Example: A pipe run is described by a variety of engineering objects. And similar to how the medium later flows through the real pipe, the information on the media must also flow through the objects.

Another application is when an attribute defines the scope of validity for another attribute.

Such a data flow only functions if the administrator has prepared the base objects and if the objects were connected accordingly in the engineering data.

You find more information on this topic in the "P&ID" manual, keyword "Data flow".
Definitions

In this case, we refer to linked attributes. The behavior of linked attributes is controlled by the administrator. The administrator can also define if the link should automatically refresh itself or if the link should be refreshed by the user.

If the user controls when linked attributes should apply information, this is called a "static link".

14.3.4.1 "Refresh ... static links" commands

Overview

These commands are only available when the attributes tab contains linked attributes.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Refresh static links on tab&quot;</td>
<td>Only updates the visible tab.</td>
</tr>
<tr>
<td>&quot;Refresh static links for all tabs&quot;</td>
<td>Updates all tabs of the engineering object.</td>
</tr>
<tr>
<td>&quot;Refresh static links for object...&quot;</td>
<td>Updates the respective selected attribute. You can also use this context menu when you want to find out which attributes of the tab are linked. This command is offered twice. Once when you click on the tab and again when you click in a statically linked attribute. In the latter case, the command is then called &quot;Refresh static linkages&quot;.</td>
</tr>
</tbody>
</table>

14.3.4.2 "Static links: Accept differences..." commands

Overview

These commands are displayed when you right-click on the tab or when you right-click in a statically linked attribute. If you accept differences, this has the following effects:

1. If the local value and the value of the linked attribute deviate, the orange switching is turned off.
2. If you accept a difference, the difference to the linked value is displayed in the tooltip.
3. The value is no longer marked as invalid in the status management.

Consequently, when the data is matched, the linked value is not accepted and the local value is retained.
The following table describes the commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Static link: Accept differences for object...&quot;</td>
<td>The differences are marked as valid as long as the default does not change.</td>
</tr>
<tr>
<td>&quot;Static link: Always accept differences for object...&quot;</td>
<td>The differences are always marked as valid, even if the value of the source changes.</td>
</tr>
<tr>
<td>&quot;Static link: No longer accept differences for object...&quot;</td>
<td>Revokes the two other commands.</td>
</tr>
</tbody>
</table>

14.3.5 Working with tables

The examples introduced so far did not contain tables. If you want to reproduce the following example, ask your administrator to prepare a corresponding base object for you.

In COMOS, there are various techniques for working with tables. This example introduces the list attribute. Another important technique is the "Object query". See also section Object queries (Page 103).

Controlling the copy area

You can copy and paste an area within a list attribute and between various list attributes. To do this, right-click on a cell and select the corresponding command from the context menu.

You are informed if the copy and the paste areas differ in size. If you still copy, the data is pasted starting from the top left.

Exchanging data with Excel

You can copy in both directions between Excel and the list attribute. Select the desired cells, copy and paste them to the other location.
14.3.6 Read-only mode

Write-protected
If an object is locked you can only read the data and not change it.
In read-only mode, you can still open attributes to the extent necessary for all entries to be readable.

Example memo text
The "..." button remains enabled if the attribute contains text. You can open long texts, so they are completely readable.

Example edit fields
You can set the mouse cursor in the edit field and move it within the text. You can scroll through long texts.

Display of the read-only mode
In read-only mode, all fields and lists have a gray background.
14.4 "Elements" tab

14.4.1 Purpose

Elements

Elements are objects. Elements are objects that belong together.

14.4.2 Hierarchy of the engineering data

General

All engineering objects that are directly located below also appear on the "Elements" tab.

Documents and links are not displayed on the "Elements" tab.
14.4.3 Inherited elements

These objects are already defined as related in the base data view. This technique is also used in the labeling systems. See also section Possibility 2: Labelling system (Page 76).

General information on inherited elements

There are inherited elements that are created automatically, as well as inherited elements that must be created manually.

- In the first case, the elements can be prepared in such a way that they cannot be deleted from the engineering data.
- In the second case, when the inherited elements need to be created manually, corresponding commands are available in the context menu of the object and on the "Elements" tab. Inherited elements that can be created manually are green or red. If you create elements manually, they can be deleted any time.

Elements themselves can have additional elements.

An element can be prepared in such a way that you can only create a specific number. If the defined limit is reached, the entry for creating the elements is no longer displayed. Of course, the elements that have been created so far are retained.

Possibility 1: Creating elements via the "Elements" tab

When you right-click a selected element, you can select from the following commands:

- "Create"
  The "Create" command creates a new element (engineering object) based on the selected template.
- "Create N"
  The command opens a window for selecting the number:
You cannot create pink colored objects. They only serve as folders:

<table>
<thead>
<tr>
<th>General</th>
<th>Attributes</th>
<th>Elements</th>
<th>Connectors</th>
<th>Strip</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>Terminal 1 (block of ten)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>Motor terminals (1, 2, 3, N, QND)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td>Lead-through terminals</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td>Lead-through terminal, 2 conductors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05</td>
<td>Lead-through terminal, 2 conductors, N</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06</td>
<td>Lead-through terminal, 2 conductors, PE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07</td>
<td>Lead-through terminal, 2 conductors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>08</td>
<td>Lead-through terminal, 3 conductors, N</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Possibility 2: Creating elements in the Navigator

The inherited elements are offered via the context menu in the Navigator:

- Connectors of elements

  The connectors of elements are displayed at the owner of the elements on the "Connectors" tab:

  In the figure above, only the connectors "I1" and "O1" are created at the owner itself. All other connectors derive from the elements.
In special cases, the connectors are already displayed in the elements list:

<table>
<thead>
<tr>
<th>General</th>
<th>Attributes</th>
<th>Elements</th>
<th>Connectors</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the above screen the connectors for the selected elements are specified in brackets. Your administrator controls whether or not the connectors are already visible here, based on the manner in which the elements were prepared.

### 14.4.4 Commands on the "Elements" tab

**Overview**

The following table describes the commands of the "Elements" context menu.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>&quot;New object (below master)&quot; Opens the properties of a new engineering object. You can specify a base object and input all other data in the usual way. Once you have confirmed with &quot;OK&quot;, the engineering object is created as a new element directly under the master, i.e. under the engineering object you had originally opened.</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Paste&quot; Creates a new element under the master based on the clipboard. You must first copy an engineering object.</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Refresh&quot; Updates the tab.</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Navigate&quot; See also section &quot;Navigate&quot; context menu (Page 58).</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Sort by name&quot; Sorts the contents of the tab by name.</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Sort by label&quot; Sorts the contents of the tab, including the virtual elements, by label.</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>&quot;Sort by description&quot; Sorts the contents of the tab, including the virtual elements, by description.</td>
<td></td>
</tr>
</tbody>
</table>
14.5 "Connectors" tab

14.5.1 Purpose and interface

General

Connectors are used to connect two engineering objects. The most important information for a connector is the type of the connector and the engineering object to which the connector is joined.

<table>
<thead>
<tr>
<th>General</th>
<th>Attributes</th>
<th>Elements</th>
<th>Connectors</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>IO</td>
<td>Connector</td>
<td>Description</td>
<td>connected to</td>
</tr>
<tr>
<td>ZE</td>
<td>P</td>
<td>II</td>
<td>=0,H1.T1.W1.0...</td>
<td></td>
</tr>
</tbody>
</table>

The connectors of the elements are also listed.

14.5.2 Usage

14.5.2.1 Setting connectors using drag&drop

Procedure

To set connectors using drag&drop, proceed as follows:

1. First open the properties of one of the two objects.
2. Click on the "Connectors" tab.
3. Search for another object in the Navigator.
4. Open the tree there until you see the connectors.
5. Drag&drop one or more connectors from the Navigator to the "Connectors" tab.
6. Click "OK" to save the changes.
14.5.2.2 Context menu

Which commands are displayed in the context menu of the "Connectors" tab depends on the respective column you make the call at.

Overview

The following table describes the commands that apply to all columns:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Connect with&quot;</td>
<td>When you copy a Comos object to the clipboard, the connectors of the object are made available via this command.</td>
</tr>
<tr>
<td>&quot;Create auxiliary connectors&quot;</td>
<td>You can connect a connector element with one and only one other connector element. If you want to attach multiple wires to a terminal, you need to create auxiliary connectors.</td>
</tr>
<tr>
<td>&quot;Cross section&quot;</td>
<td>The corresponding details are assigned to a corresponding connection. However, you can only see the assigned information once the corresponding columns have been made visible.</td>
</tr>
<tr>
<td>&quot;Color&quot; &quot;Type info&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Columns&quot;</td>
<td>• &quot;Reset&quot;: Removes all filters and other modifications&lt;br&gt;• Additional commands: Show more columns. All displayed columns are marked with a check mark in the context menu. To hide the columns again, select the command again.</td>
</tr>
<tr>
<td>&quot;Navigate&quot;</td>
<td>Navigates to the object of the column.</td>
</tr>
<tr>
<td>&quot;Refresh&quot;</td>
<td>Updates the tab.</td>
</tr>
<tr>
<td>&quot;Properties&quot;</td>
<td>Displays the properties for the object of the column.</td>
</tr>
</tbody>
</table>

"Connected to" column

The "Connection" command is shown in the context menu for this column. The following table describes the subordinate commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Disconnect&quot;</td>
<td>Disconnects the connection between two connectors.</td>
</tr>
<tr>
<td>&quot;Disconnect (keep wires)&quot;</td>
<td>Disconnects the connection between two connectors.</td>
</tr>
<tr>
<td>&quot;Disconnect (keep wires at target)&quot;</td>
<td>Disconnects the connection between two connectors.</td>
</tr>
<tr>
<td>&quot;Cut&quot;</td>
<td>Cuts the counterpart connector, including the wire information. You can now insert the opposite connector.</td>
</tr>
<tr>
<td>&quot;Paste&quot;</td>
<td>Pastes the wire that is located in the clipboard. This means that the selected connector is connected to the connector in the clipboard.</td>
</tr>
</tbody>
</table>
14.5.3 Saving the settings (scheme)

"Load/save scheme" button

You can sort, filter and expand lists. When you open a different list of the same category, these settings are saved and made available again.

If, for example, you change some of the settings in the "Connectors" tab for an engineering object and then open another engineering object, the "Connectors" tab there is sorted and filtered in exactly the same way.

To save a separate scheme for each engineering object, click on the "Load/save scheme" button and select the "Screen scheme > Save" command.

Regard that every user can overwrite a scheme.

The "Scheme per object" option is used to control whether a saved scheme is to be loaded automatically. If the option is selected, a scheme is automatically searched when the properties of an engineering object are open. If the option is not selected, the scheme has to be loaded manually using the "Screen scheme > Load" command.

The "Delete" command deletes the custom scheme. The most recently generated scheme is then used again for this object.

14.6 Coming up next

You now know how to individually edit objects.

To edit multiple objects at one time, you can use the bulk processing.

The tools for bulk processing have a common area, the object query. This is an interface in which you can view, sort and filter objects.

See also

Object queries (Page 103)
Bulk processing for engineering objects (Page 111)
Editing engineering data

14.6 Coming up next
Object queries

15.1 Purpose

General

You use object queries to search for objects you can sort, filter and edit. A number of general object queries have been prepared in the COMOS-DB.

To call the queries, click "Query" button in the toolbar and select the desired query.

For example, select the "Queries for engineering objects > Query: Engineering objects" command.

The interface of a query is divided into four main areas:

1. Toolbar
2. General data
3. Object browser
4. Buttons
15.2 General data

Start values

The general data contains several lists in which you can set the starting values for the query. Drag&drop the start values from the Navigator into the list. The following table describes the lists:

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Class(es)&quot;</td>
<td>Here you can specify the class and subclass that you wish to search for.</td>
</tr>
<tr>
<td>&quot;Start object(s)&quot;</td>
<td>Here you define the object from where you wish to start the search. You can also set multiple objects as start objects.</td>
</tr>
<tr>
<td>&quot;Base object(s)&quot;</td>
<td>This only displays objects that were derived from this base object type. You can also drag multiple objects into the field. Either base objects or engineering objects can be set. In the latter case, the base objects belonging to the engineering objects are determined.</td>
</tr>
</tbody>
</table>

15.3 Toolbar

Overview

The following table describes the buttons in the toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Navigate&quot;</td>
<td>This opens a list with navigation commands. The topmost entry is usually &quot;Object&quot;, the following entries vary. Click on one of the entries to navigate to the respective object.</td>
</tr>
<tr>
<td>&quot;Refresh&quot;</td>
<td>Updates and recalculates the query.</td>
</tr>
</tbody>
</table>
Object queries

15.4 Object browser

### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Save / Load...&quot;</td>
<td>Opens a selection of different storage options and loading of settings:</td>
</tr>
<tr>
<td></td>
<td>- &quot;Save&quot;: Saves the object query with all its settings and calculations.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Save as...&quot;: Saves a copy of the object query. Drag&amp;drop the object</td>
</tr>
<tr>
<td></td>
<td>below which you want to save the query into the &quot;Save as&quot;. Enter a</td>
</tr>
<tr>
<td></td>
<td>name and a description for the query.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Save as file...&quot;: Saves all settings of the query in XML format.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Load from file...&quot;: Loads an XML settings file. A safety prompt</td>
</tr>
<tr>
<td></td>
<td>appears since the available current settings are overwritten during</td>
</tr>
<tr>
<td></td>
<td>loading.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Load old scheme...&quot;: Use this command to load and use a scheme. A</td>
</tr>
<tr>
<td></td>
<td>safety prompt appears since the available current settings are</td>
</tr>
<tr>
<td></td>
<td>overwritten during loading.</td>
</tr>
<tr>
<td></td>
<td>- &quot;Load from inheritance source&quot;: Loads the scheme that had originally</td>
</tr>
<tr>
<td></td>
<td>been created in the base object.</td>
</tr>
<tr>
<td>&quot;Print list&quot;</td>
<td>Prints the query.</td>
</tr>
<tr>
<td>&quot;Export&quot;</td>
<td>Exports the result of the object query to other program formats. This</td>
</tr>
<tr>
<td></td>
<td>exports only the list itself and not all settings of the object query.</td>
</tr>
<tr>
<td>&quot;Properties&quot;</td>
<td>Displays the general data of the object query.</td>
</tr>
<tr>
<td>&quot;Script block action&quot;</td>
<td>Opens an input area for scripts.</td>
</tr>
<tr>
<td>&quot;Search at once&quot;</td>
<td>The &quot;Search at once&quot; button recalculates the data for each change. If you</td>
</tr>
<tr>
<td></td>
<td>do not need continual updating, disable the &quot;Search at once&quot; button.</td>
</tr>
<tr>
<td></td>
<td>In this case, the &quot;Search&quot; button becomes available and you can use it</td>
</tr>
<tr>
<td></td>
<td>to manually start the evaluation of an object query.</td>
</tr>
<tr>
<td>&quot;Find&quot;</td>
<td></td>
</tr>
</tbody>
</table>

### Other buttons

All other buttons depend on the type of the object query. See also section Bulk processing for engineering objects (Page 111).

15.4 Object browser

15.4.1 Changing the order of the columns

### Procedure

To change the order of the columns, drag&drop a column to the desired location.
15.4.2 Changing the row height

Procedure

To change the row height, proceed as follows:

1. Right-click on a column header.
2. Select the "Options" command from the context menu.
3. Specify the desired row height in the "General" tab:

   ![Options window]

   - **Row height**
   - **Headline size**
   - **Number of fixed columns**
4. Click "OK".

Result

The row height is changed.

Alternative procedure

1. Alternatively, select "Record selectors" option in the "Options" window.
   This causes blue cells to appear at the left in the object list.
2. Move the mouse pointer to a selected position on the separator line of the record selector until it changes into a double arrow.
3. Keep the mouse button pressed and and drag the mouse downwards until you reach the desired row height.
   All other rows are automatically set to the selected value.
15.4 Object browser

15.4.3 Changing the column width

Procedure

To change the column width, proceed as follows:

1. Change the column width by slowly moving the mouse cursor in the title bar over the right-hand separator line of the column that you wish to change.
2. When the mouse cursor changes into a double arrow, press the left mouse button and drag the mouse to one side until you reach the desired column width.

Result

The change to the column widths only applies to the selected column.

15.4.4 Sorting the object list

Procedure

To sort the object list, proceed as follows:

1. Right-click in the column header.
2. Select the "Sort" command in the context menu.
3. Select one of the following options:
   - To sort the list in ascending order, click on the "Ascending" command.
   - To sort the list in descending order, click on the "Descending" command.
   - If you want to define your own sorting, click on the "Edit" command. You find more information on this topic in the "Queries" manual, keyword "Sorting".

General

Rows are always kept together. If you set a sorting in a column, the rows of the entire table are arranged accordingly.

Sorting operations in multiple columns take effect sequentially. If you first sort in column B and then in column A, sorting is first performed according to B and then according to A within this sorting. If you delete the sorting B, only sorting A is used and the table is newly arranged accordingly.
15.4.5  Filtering the object list

Procedure
To filter the object list, proceed as follows:
1. Right-click in the column header.
2. Select the "Filter > Edit" command from the context menu.
3. Enter the desired information in the "Filter element" window.
4. Click on the "OK" button to confirm your entries.

Result
The Object list is filtered accordingly. The text is displayed in bold in column header. This is how you recognize an active filter. You find more information on this topic in the "Queries" manual, keyword "Filters".

15.4.6  Displaying and editing attributes in the object list

List area
You can add additional columns to the attributes in the list area. Drag&drop an attribute from the Navigator into the list area.

Result
You now see a new column, but there will not be an entry for each row in the column. If the cell is empty, either nothing has been entered in the attribute or the object does not have this attribute. You can tell from the context menu which of these two cases applies.
Right-click in the empty cell of the attribute column.
- If the attribute exists but it is empty, one of the commands you see is "Navigate > Attribute".
- If the attribute does not exist for this object, you only see the "Refresh" command.
15.5 Working within object queries

General

In object queries you can work similar to the way you work in the properties of an object:

- Since a query uses a list display, this restricts what can be input to what can be displayed in the form of text. This includes simple texts, lists, attributes, etc.
- Graphical information that can be edited in interactive reports cannot be edited within object queries.

Editable columns

Editable columns are displayed in white, those that cannot be edited are gray. In the following example, you can edit the "Name" column but not the "Location" column:

```
<table>
<thead>
<tr>
<th>Location</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>R1</td>
</tr>
</tbody>
</table>
```

The administrator can prepare the object queries in such a way that certain columns are editable and others are not. In addition, columns that are added as new have "Not editable" as a default setting.

To edit a text, double-click in the editable column. The insertion cursor is now in the cell and the text can be edited.

15.6 Deleting in the list

Note

If only the "Delete" command is shown in the context menu of an object in the object list, this command deletes the object from the COMOS data.

You can terminate the action with the "Cancel" button as long as you have not saved the object query. All actions carried out since the last save operation are undone and any objects that were deleted are restored.

If you have deleted an object in the object query, the list is not automatically refreshed. The object then appears in the list with the "<<deleted>>" notation.

This entry disappears once you refresh the query.
15.7 Coming up next

Queries are also used in bulk processing. With bulk processing you can quickly search large volumes of engineering objects and edit them.

See also

Bulk processing for engineering objects (Page 111)
Bulk processing for engineering objects

16.1 Purpose

General

The bulk processing function allows you to input and change general data and attribute values for large amounts of engineering data in a quick and efficient way.

To start the bulk processing of engineering objects, click on the "Extra > Bulk processing > Bulk processing for engineering objects" menu.

16.2 Interface

Overview

The left-hand area of the bulk processing window consists of an object query. See also section Object queries (Page 103). You find more information on this topic in the "Queries" manual, keyword "Sorting".

You see the fields for general data in the right window area. You can use these fields in the usual way. You set references as usual using drag&drop.

In the bottom right area you can see the "General" tab and the display of the tabs.
16.3 Carrying out a bulk processing operation

16.3.1 Setting starting values

Procedure

To set a start object for bulk processing, drag&drop an engineering object from the Navigator to the "Start object(s)" field:

This defines the root.

16.3.2 Collecting attributes

General information on drag&drop

Bulk processing is used to set new values for existing attributes. You can neither delete attributes from the database nor create new ones.

You use drag&drop to determine which attributes are displayed in bulk processing. Basically, you can drag attributes from the Navigator or the open properties of an object and drag&drop them into bulk processing.

Procedure

To collect attributes, proceed as follows:

1. Select an object in bulk processing.
2. Right-click on the object.
3. Select the "Navigate > Object" command in the context menu.
4. Drag & drop an individual attribute from the Navigator into the "General" tab.

**Result**

When you do this, you do not create a new attribute; you only make the attribute available so that you can subsequently change its value.

**Alternative procedure**

To assemble multiple attributes simultaneously, drag a tab from the Navigator and drop it on the "General" tab.

**Result**

The tab with all attributes is displayed in the lower right area of the bulk processing.
16.3.3 Saving the inputs

**Settings**

To save your settings for bulk processing, click on the "Save/load" button.

If you now close the bulk processing and then open it again, your settings for the starting values and the collected attributes still exist.

If you have selected the suitable object, the collected attributes are displayed.

16.3.4 Marking objects

**Changes**

The entries you make at the right side are only applied to the on the left selected objects.

You can select individual items with the <Shift> + <Ctrl> key combination as usual in Windows.

![Table of objects](image)

Make sure that all selected objects have the attributes in question.

Bulk processing functions even when objects selected in the list on the left do not have the to be edited attribute. In such a case your inputs only take effect on suitable objects. The attributes that have been dragged into the working area are only displayed if the last object selected in the list on the left also has this attribute.
16.3.5 The context menu in the right area of bulk processing

Context menu of the tabs

The tabs and the attributes are collected in the right area. Right-click on an empty area to open the context menu.

![Context menu of the tabs](image)

The top area of the context menu has the following meaning:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Design mode&quot;</td>
<td>Switches the tab to Design mode. This allows you to rearrange the attributes you have collected in bulk processing to suit your needs. These modifications are only visible in bulk processing. The individual changes are lost when you close bulk processing.</td>
</tr>
<tr>
<td>&quot;Delete tab attributes&quot;</td>
<td>Deletes this tab from the working area of bulk processing. The engineering data are not affected. The tab is still available there.</td>
</tr>
<tr>
<td>&quot;Delete all attributes&quot;</td>
<td>Deletes all tabs and all attributes from the working area of bulk processing. The engineering data are not affected. The tabs and attributes are still available there.</td>
</tr>
<tr>
<td>&quot;Show/Hide 'General' tab&quot;</td>
<td>Hides the &quot;General&quot; tab.</td>
</tr>
<tr>
<td>&quot;Show name&quot;</td>
<td>Displays the name instead of the description for all tabs and attributes.</td>
</tr>
</tbody>
</table>

The lower area of the context menu displays the same commands that you also see in the properties of the tab. See also section [Copying data manually](#) (Page 90).
16.3.6 Changing general data and attributes

General data

The fields for general data are located in the upper area. You can use these fields to change each property.

When you select a group of objects, some of the fields have a yellow background. This yellow color indicates that not all selected objects in this field have the same value. You can always change the fields with a yellow background. The information of the first object in the current selection is displayed.

There are two cases here:

- The field may contain identical values. If you change an entry when making a multiple selection, all selected objects are assigned this entry. After entering a new value, the text is displayed in black again.
- The field may not contain the same values. COMOS puts out a warning and attempts to automatically adjust the entry, e.g. automatic continuation of counting.

Attributes

You can change the attributes in the working area as usual. The entries apply to all selected objects that have this attribute.

16.3.7 Completing the bulk processing

Applying changes

Click on the "Apply" or "OK" button to save your changes. If you click on the "Cancel" button, your changes are not saved.

16.4 Coming up next

You have now become familiar with a number of important tools you can use to create and edit objects.

The easiest way to see your work progress is to use the status management. The status management is used to determine and display the editing state of objects.

See also

Status management (Page 117)
Status management

Purpose

The status management is a control instrument in COMOS. It is used to classify objects. For example, you can specify which data you still want to edit and which data you have already completed.

You find more information on this topic in the "Properties" manual, keyword "Query-based status management".

17.1 Status information

17.1.1 Status

General

The status allows control sequences to be delineated in terms of content. Your administrator can change the delineation. A maximum of 13 status types can be created. The states are defined beforehand for you as user.

17.1.2 Status value

General

The status values display the progress of the data monitoring within each state.
The displayed texts of each status value can be configured by the administrator.
Example

Here is an example of texts of two states from the COMOS-DB:

<table>
<thead>
<tr>
<th>Status Type</th>
<th>For status type &quot;1 PE&quot;</th>
<th>For status type &quot;9 3D collision&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Gray</td>
<td>Not processed</td>
</tr>
<tr>
<td>1</td>
<td>Orange</td>
<td>Changed</td>
</tr>
<tr>
<td>2</td>
<td>Blue</td>
<td>Processing</td>
</tr>
<tr>
<td>3</td>
<td>Green</td>
<td>Finished</td>
</tr>
</tbody>
</table>

17.2 Using status management

17.2.1 Initial status value

The status value of a newly placed object is defined in the base data. Usually that will be status 3, "Ready".

17.2.2 Setting the status in the properties

Procedure

To set the status in the properties, proceed as follows:

1. Open the properties of an object.
2. Click on the "Status" tab.
3. To change the status for a status value, select the desired entry from the corresponding list.
4. Select one of the following options:
   - Click on the "Set" button to set the status.
     A check is made to determine if the selection is valid. If the value is valid, the new status value that was selected manually is set recursively for the object and for all objects of its hierarchical substructure.
     If the value is invalid and the object or an object from its hierarchical substructure returns a lower value, the lower value is set.
   - Click on the "Check" button to check the status.
     The current object and all objects of its hierarchical substructure are checked recursively for their status values. If the object or one of the objects from the substructure returns a lower value, the lower value is taken over and set for the current object.

5. Click "OK" to confirm your entries.
17.2.3 Setting the status in the Navigator

Procedure

To enable the status display in the Navigator, proceed as follows:

1. Right-click in the white area of the Navigator.
2. Select the "Status display > <desired status>" command in the context menu.

Result

If you have enabled one of the states as the status display, all objects in the Navigator are displayed in color. The colors symbolize the respective status value.

The respective color of an object in the Navigator is taken from the settings for the object in the "Status" tab of the properties.
17.2.4 Automatic status change

Rules

- You manually set the status for an object, all objects located below it are given this status as a maximum. Lower status values are retained.
- If you change the status for an object manually, an automatic check is performed for all objects above it to see if they can also be assigned this status. The test is positive if all objects located underneath an object also have the newly set status as minimum value.

17.2.5 Status calculation protocol

Values

If you cannot set a status value, the "Status calculation protocol" window opens. It contains information on why the status of the object cannot be set.

You can immediately change the following values in this window:

- "Value"
- "Linked value"
- "Value min"
- "Value max"

17.3 Coming up next

COMOS can also be used for engineering with electronic documents, especially electronic drawing sheets, also known as electronic drawing sheets.

See also Documents (Page 123)
17.3 Coming up next
18.1 Definition of documents

General

The term document is used in a very broad sense within COMOS and includes most of the file types you already know. You can open a document, such as Excel or Word, from within COMOS, work there in the usual way and save the completed document in COMOS. You need to have the corresponding programs installed on your PC for this.

Documents are managed as objects within COMOS.

There are also types of documents that are shipped together with COMOS. This applies in particular to reports. See also section Reports (Page 131).

Properties of documents

Like all objects, document objects also have properties. See also section Definition of the term "object" (Page 33).

If the report is locked, you can neither change the properties nor the report itself. See also section Toolbar (Page 62).

You only need the "General" tab for new documents. See also section "New document" command (Page 126).

The "Attributes" tab functions in the exact same way as described above. See also section "Attributes" tab (Page 88).

18.2 Document storage

General

The location where electronic documents are stored in the COMOS project depends solely on the operational requirements.

You usually place documents on the "Units" or "Location" tab. The administrator can configure COMOS in such a way that links to the documents are created automatically on the "Documents" tab and unique document numbers are applied. You find more information on this topic in the "Document Management" manual, keyword "Document groups".
18.3 Inherited documents

General

The administrator can prepare a base object in such a way that one or more document objects are immediately available as a fixed constituent part in the engineering project.

There are two possible ways in which inherited documents are created:

- When you create an engineering object based on the base object, the document is automatically created as well.
- The document is available in the context menu.

Creating inherited documents

If the inherited document is available in the context menu, click on it:

A terminal plan has been prepared in the above example. Once you have selected the entry in the context menu, the report is created below the object.

Depending on the settings, an inherited document may be created only once or several times.
18.4 Opening documents

Procedure

To open a document, proceed as follows:
Select one of the following options:
- To open the document, double-click on it in the Navigator.
- To open the properties of the document, right-click on the document in the Navigator and select the "Properties" command in the context menu.

18.5 Using external documents in COMOS

You can make most of the documents and files on your PC available for use in COMOS.

Procedure

To use an external document in COMOS, drag the document from the Windows Explorer and drop it into the Navigator.

The user is prompted to specify how the document is to be made available:

Result

You see a new document object in the Navigator.
Webpages

You can make web pages from the Internet (URLs) available in the same way. To do this drag&drop the icon of the address bar from the browser into the Navigator:

This creates a general document. To open the browser and load the web page, double-click on the general object.

18.6 "New document" command

18.6.1 Select the document type

Procedure

To open a document type, proceed as follows:

1. Right-click on an engineering object in the Navigator.
2. From the context menu, select the "New > General > New Document" command.
3. Select the desired document type from the "Type" list in the "General" tab.
4. Click on the "OK" button to confirm your entries.

If you want to open an external document, the corresponding software must be installed.

You can start working at once with some documents, for example with "Excel", "Word" or "Text file". However, additional information is needed for many document types. Above all, this applies to reports. See also section Reports (Page 127).

Specifying properties according to document type

The labeling and contents of the middle tab depend on the document type you select.
18.6  "New document" command

18.6.2  Reports

18.6.2.1  Evaluation Reports

Definition

Evaluation reports are the basis for data sheets and lists. You find the "Report" tab in the properties:

<table>
<thead>
<tr>
<th>General</th>
<th>Attributes</th>
<th>Report</th>
<th>Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report template: *** Not set</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report object: Owner: 🍀 #ALAN1 Drive 1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

"Report template" field

The report template also determines the drawing type. When you click on the "..." button, the "Select report template" window opens.

Select the desired report template in the "Select report template" window.

The base project is first offered in this window. If the "CRp report templates" document group is available in the "Documents" tab, it is offered as the default. If there is no "CRp report templates" document group, the dialog window is initialized with the project root.

Set the "Current" option to display the currently open engineering project. If the "CRp report templates" document group is available on the "Documents" tab, it is offered as the default; otherwise the project root is offered. You switch back to the base project with the "Base" option.

"Report object" field

The object of a report is the basis from which all active and automatic functions of a report are executed. There can be no document that does not have an object.

The "Remove reference" button deletes a manual entry and resets the previous setting from the base data, usually the owner.
18.6.2.2 Interactive Report

Definition

Interactive reports are the basis of diagrams and drawings. You find the "Report" tab in the properties:

See also section Evaluation Reports (Page 127).

File storage (backup copies)

Three instances of the document are saved for interactive reports:

1. CRp file
   This is the work file.

2. BAK file
   Each time you save the report, the BAK file is overwritten by the most recent version.

3. TMP file
   This file is produced during the working session. If the document is closed correctly, the TMP file is also deleted.

18.6.3 External documents (default interface)

This section applies to:

- Adobe PDF
- AutoCAD drawing
- Conval (all Conval types)
- Excel
- PowerPoint
- Unknown document
- Word
Restricted default interface

This section also applies to the following documents, however, with the following restrictions:

- Image document (Imagineer)
- Logocad drawings (from V.3.0 onwards)
- If Triga has not been installed, Triga documents can nonetheless still be displayed and printed.
- Smartsketch
- Text
- TIFF document

Tab in the properties

The following table describes the control elements of the tab that appears depending on the selected external document type:

<table>
<thead>
<tr>
<th>Control element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Normal&quot; option</td>
<td>A new external document is created by COMOS. There is no template.</td>
</tr>
<tr>
<td>&quot;File link&quot; option</td>
<td>The object is linked to a document in the file structure. There is no template. This option makes a reference to an existing external file.</td>
</tr>
<tr>
<td>&quot;Reference&quot; option</td>
<td>Shows the &quot;Template&quot; field, in which you can specify a template. A new document is created based on this template. A temporary file is also created.</td>
</tr>
</tbody>
</table>

18.7 Coming up next

In most cases, you use reports:

- The evaluation reports offer an overview of the engineering data in tabular form.
- Interactive reports are the electronic drawing sheets of COMOS.

See also

Reports (Page 131)
18.7 Coming up next
19.1 Report types

Evaluation Reports

Evaluation reports evaluate the existing stock of data and display the results. Evaluation reports contain lists, drawings, text fields and additional elements that are used to document and display database-based plant engineering. Typical evaluation reports are terminal diagrams or parts lists.

You can edit the fields highlighted in green. The values entered are written to the corresponding attribute of the object after the report has been saved.

Interactive Reports

Interactive reports can contain all elements of an evaluation report, but you can also perform design engineering on the drawing sheet. Interactive reports allow you to drag&drop predefined objects onto the sheet. In addition, the usual drawing tools are available.

Drawings types

You find prepared reports for many different purposes in the COMOS-DB. There are examples of various drawing types for interactive reports, for example, circuit diagrams, P&ID engineering, design diagrams, etc.

There are examples for the various engineering phases for evaluation reports, for example, terminal diagrams or document directories.

See also section "New document" command (Page 126).
19.2 Basic functions in all reports

19.2.1 General functions

Overview

The following table describes the buttons in the toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“Reevaluate document”</td>
<td>This function generates the report again and displays the result.</td>
</tr>
<tr>
<td></td>
<td>“Refresh screen”</td>
<td>The screen is generated again.</td>
</tr>
<tr>
<td></td>
<td>“Print”</td>
<td>Prints the report to the Windows default printer.</td>
</tr>
<tr>
<td></td>
<td>“Navigate to predecessor”</td>
<td>You can jump between pages if the report has more than one page.</td>
</tr>
<tr>
<td></td>
<td>“Navigate to successor”</td>
<td></td>
</tr>
</tbody>
</table>

19.2.2 Zoom functions

Overview

Zooming manually

The zoom function can enlarge any part of the working area by a factor of up to 800% or expand the working area to adapt to the window size.

Press the <Ctrl + Alt> keys and drag the mouse to create a frame.

Zoom all

Press the <Ctrl + Alt> keys and click once on the document.

- First click: Zoom on all placed elements
- Second click: Zoom on the document sheet
19.3 Interactive Reports

19.3.1 Mouse operation on the report

19.3.1.1 Drag&Drop

Objects per drag&drop

To use an object, drag&drop it onto the diagram.

See also section Placing objects (Page 136).

Attributes per drag&drop

If the owner is already placed on the report, you can also drag&drop attributes onto an interactive report.

The result is that the "Value" and the "Unit" of the attribute, if available, are displayed as text.
19.3.1.2 Mouse movements

Drawing a frame

To draw a frame, hold down the left mouse button and move the mouse.
All objects that are completely or mainly within the frame are selected.

Moving the sheet

To move the sheet, hold down the right mouse button and move the mouse.

19.3.1.3 Important context menus in interactive reports

Overview

- "Delete" and "Delete > Object" command:
  Both commands appear if the following is true for at least one of the selected objects:
  - The object is fixed.
  - It has a planning object.
  - The object is not an element.
  - The object only has one DocObj.
  The "Delete" command only deletes objects from reports. The "Delete > Object" command also deletes the object from the database.

- "Options > Hide text" command
  If an object on an interactive report has texts, you can show and hide the texts.

- "Graphical settings" command
  The administrator can also make specific attributes of an object available by using a context menu at the symbol. A "Graphical settings" context menu is then available for the symbol in the interactive report. The attributes are offered in this menu.

Paste command

When you select the "Paste" command, a submenu with different options appears:

- "Automatically":
  The effect of this command depends on the drawing type of the report and on the types of the objects that are copied.

- "At same position":
  A second engineering object is created in the Navigator on the same hierarchy level.
19.3 Interactive Reports

- "Parallel to document":
  A second engineering object is created in the Navigator parallel to the document.
- "Below document":
  A second engineering object is created in the Navigator below the document.
- "Keep object":
  The copy of the symbol generated in the report points to the same engineering object.

19.3.2 Buttons in interactive reports

Overview

In addition to the control elements common to all reports, the following options are also available to you in interactive reports:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="save_icon" alt="Save" /></td>
<td>&quot;Save&quot;</td>
<td>Saves the interactive report</td>
</tr>
<tr>
<td><img src="cut_icon" alt="Cut" /></td>
<td>&quot;Cut&quot;</td>
<td>Cuts the selected object and places it in the COMOS clipboard. This function does not use the Windows clipboard.</td>
</tr>
<tr>
<td><img src="copy_icon" alt="Copy" /></td>
<td>&quot;Copy&quot;</td>
<td>Copies the selected object onto the COMOS clipboard. This function does not use the Windows clipboard.</td>
</tr>
<tr>
<td><img src="paste_icon" alt="Paste" /></td>
<td>&quot;Paste&quot;</td>
<td>Pastes the contents of the COMOS clipboard. This function does not use the Windows clipboard.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td></td>
<td>Defines the snap-to grid. All symbols, lines, and texts care always placed on one of the grid points. The symbols have a placement point that only seldom coincides with the top left corner of the symbol. When you press the &lt;Shift&gt; key, the grid is ignored.</td>
</tr>
<tr>
<td><img src="identify_icon" alt="Identify" /></td>
<td>&quot;Identify&quot;</td>
<td>An object is selected when you click on it with this tool. You can then move the object. Additionally three text fields appear in the toolbar that include the name, label and description of the selected object. If only a single object is selected, the second mouse-click activates the grab points. If several objects overlap, click again on the same point to select the object on the next, lower level.</td>
</tr>
<tr>
<td><img src="line_icon" alt="Line" /></td>
<td>&quot;Line&quot;</td>
<td>This is used to draw graphic lines. These lines are not objects, in particular they are not connections. These lines are solely used to graphically design a page. You can use the properties to set the line thickness and line type.</td>
</tr>
</tbody>
</table>
19.3 Interactive Reports

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Line parameter&quot;</td>
<td>This button is shown when you click on the &quot;Line&quot; button. The button opens the &quot;Line parameter&quot; window for the defaults. You find more information on this topic in the &quot;Reports - Basic Operation&quot; manual, keyword &quot;Line parameter&quot;.</td>
</tr>
<tr>
<td></td>
<td>&quot;Arc&quot;</td>
<td>Draws an arc. To do this, click several times on the report. COMOS then draws an arc through the points. If you click on this button, additional buttons appear. You find more information on this topic in the &quot;Reports - Basic Operation&quot; manual, keyword &quot;Circle tool&quot;.</td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot;</td>
<td>Creates a &quot;&lt;&lt;new text&gt;&gt;&quot; text field. To edit the text, right-click on the text field and select the &quot;Properties&quot; command in the context menu. You find more information on this topic in the &quot;Reports - Basic Operation&quot; manual, keyword &quot;Placing texts&quot;.</td>
</tr>
<tr>
<td></td>
<td>&quot;Connection&quot;</td>
<td>This tool automatically searches for connection points of the objects on the report. The &quot;Connection&quot; tool differs depending on the drawing type with which you are currently working.</td>
</tr>
<tr>
<td></td>
<td>&quot;Assign object&quot;</td>
<td>This tool is used to retrospectively modify objects in the interactive report. The &quot;Assign object&quot; tool differs depending on the drawing type with which you are currently working.</td>
</tr>
</tbody>
</table>

19.3.3 Placing objects

19.3.3.1 Overview

Requirement: Symbol for relevant drawing type

When an object is dragged onto an interactive report, COMOS checks which drawing type the interactive report has and whether a symbol for this drawing type has been prepared at the object. You can only place the object on the report if this is the case.

For this reason, a pump, for example, cannot be placed on a circuit diagram. The pump is not an EE object and therefore does not have a symbol for the corresponding drawing type.

Function of the symbol

The symbol is the graphical representation of an engineering object. You can also access the properties of the engineering object via the symbol.

For example, if you select a valve symbol on the report, you can call the "Properties" command from the context menu and thereby directly switch from the drawing to the properties of the valve.
Four placing types

There are four ways of placing a symbol on a report:

- Via the symbol bar that is prepared in the report
- Via the "Base objects" tab in the Navigator
- Via the "Units" tab in the Navigator
- By placing another interactive report or a template on the interactive report.

See also

- Through the symbol bar for base objects (Page 137)
- Via the "Base objects" tab (Page 139)
- From the engineering data (Page 139)
- Placing templates (Page 140)

19.3.3.2 Through the symbol bar for base objects

Introduction

The easiest and fastest way to place an object on an interactive report is to use the base object symbol bar of the report.

This symbol bar is created by your administrator and is automatically available when you open an interactive report. It is drawing type-specific, this means that in a circuit diagram you will see a base object symbol bar that is different from the one you see in a P&ID.
Reports

19.3 Interactive Reports

Procedure

To place an object on an interactive report, proceed as follows:

1. Click on a symbol.

2. Hold down the mouse button and drag the mouse to the desired position in the report.

3. As soon as you release the mouse button, one symbol is placed on the report.

Result

The corresponding object is created in the Navigator. After releasing the mouse button, the mouse pointer switches back to the normal arrow display and function.

Creating multiple identical objects

1. Click on a symbol.

   Do not hold down the mouse button. The symbol is shown at the mouse pointer.

2. Click several times on the report at different positions.

Result

The corresponding number of objects is created in the engineering data. To disable the stamp mode, right-click on the report or enable the "Identify" button.
19.3.3.3 Via the "Base objects" tab

Introduction

The symbol bar for base objects is simple and clear. If you do not find an object in the symbol bar, you can place the object via the "Base objects" tab.

Requirement

For this, you must know the structure of the base data. Ask your administrator concerning this.

Procedure

1. Click on the "Base objects" tab in the Navigator and select the desired base object.
2. Select the base object and drag & drop in onto the report.

Result

The corresponding engineering object is created in the engineering data.

19.3.3.4 From the engineering data

Requirement

The engineering objects you want to use are already available on the "Units" or "Locations" tab.

Procedure

To place an engineering object on the report, proceed as follows:
1. Select the desired object on the "Units" or "Locations" tab.
2. Drag & drop the object onto the open report.

Result

In this case, no new engineering object is created in the Navigator.
Placing a report on a report

You can also place a report on another report.

A symbol at the top left corner indicates that a complete document was placed here. Initially you can only select the symbols placed on the first report together, since the report has not yet been ungrouped. To ungroup the report, select the "Break apart placed document" command in the context menu.

All objects that were previously located on the first report are placed on the second report. The first report is automatically deleted. You can now select the objects individually.

In this manner, you can pre-plan small units of a plant on a small, concise report and then merge them with the remaining units on a common drawing.

19.3.3.5 Placing templates

If specific modules in a plant appear repeatedly, your administrator can generate a template, which you can then use at any time.

Procedure

To place a template, proceed as follows:

1. Open an interactive report
2. Right-click in the report.
3. Select the "Place template" command from the context menu.

The "Select document as template" window opens. It contains a Navigator that also contains a preview window. The template has a location or a unit as its root.
4. Select a unit or location.

   The template is displayed in the preview window.

```
4. Select a unit or location.

   The template is displayed in the preview window.
```

5. Click "OK".

**Result**

All objects that are placed on the template are copied to the report.

**19.3.3.6 Result in the database**

When you place a symbol on the P&ID via the base object toolbar of the report, drag a base object from the Navigator to the drawing, or place a template, the corresponding engineering objects are automatically created in the engineering data.

Depending on the module in which you are working, these objects are created in parallel or below the interactive report.

**19.3.4 Symbol operations on interactive reports**

**Symbols**

You can change symbols that are placed on interactive reports.
19.3 Interactive Reports

See also  
Move (Page 142)  
Scaling and rotating (Page 142)  
Distort (Page 143)  
Graphical properties (Page 145)  
Editing symbol texts (Page 145)

19.3.4.1 Move

Procedure

To move the symbol, proceed as follows:

1. Click once on the symbol.
   The symbol is highlighted in pink.
2. Drag & drop the selected symbol to the desired position.

Result

All connections, texts etc. are automatically moved as well.

19.3.4.2 Scaling and rotating

Procedure

To scale and rotate the symbol, proceed as follows:

1. Click on the symbol.
   The symbol is selected.
2. Click on the symbol once again.
   A frame appears around the symbol with square grab points at the corners and round rotations points.

   ![Diagram of symbol with grab points]

3. In order to scale the symbol, click on the turquoise grabs in the corners, hold down the mouse button and drag the symbol to enlarge it.
   All connections, texts etc. are automatically moved as well.
4. In order to rotate the symbol, click on the green, round grab, hold down the mouse button and drag the green grab around the symbol.

The connectors, texts etc. will be automatically carried along. You can set a more precise control of the rotational angle in the "Options > Graphics Properties" context menu. See also section Graphical properties (Page 145).

19.3.4.3 Distort

Procedure

To distort the symbol, proceed as follows:

1. Click on the "Transform" button.
   Additional buttons are displayed.
2. Click on the "Distort" button.
3. Click on the report to set the transformation vector.
4. Move the mouse pointer to the desired position.
5. Click again in the report.

Unlike other transformation tools, after specifying the transformation vector, the appearance of the mouse pointer remains the same. Select the objects to be moved by drawing a polygon around them:
6. To define the polygon, click in the report until all desired objects are enclosed.

![Diagram](image_url)

**Result**

When the polygon is closed, the transformation is automatically executed.

**Difference to moving**

The difference to moving is that all connected objects as well as purely graphical elements (e.g. lines) that penetrate the selection polygon or touch it are included. All lines between the point within the selection polygon and the last corner point outside are stretched as shown in the figure below:

![Diagram](image_url)

This behavior applies to all graphical constructions consisting of lines. Circles and circular arcs are treated as if they belong to the object. They are only moved, but are not stretched.
19.3.4.4 Graphical properties

Properties of the symbols

To open the "Graphical properties" window, right-click on the symbol and select the "Options > Graphical properties" command in the context menu.

The "Lines" control group relates to all lines of the selected symbol.

For some objects, the settings are saved in the database. In this case, the "Display mode" attribute tab is available in the properties of the engineering object.

Note that not all settings always are in effect. In the base project, the administrator can set whether the commands of the "Graphical properties" context menu have an effect on a symbol at all. You find more information on this topic in the "Reports - Basic Operation" manual, keyword "Symbol script".

19.3.4.5 Editing symbol texts

A symbol can have its own text. They usually show the description or label of the symbol. When you select a symbol, the assigned text is also selected.

Procedure

To change the display and position of a symbol text, proceed as follows:

1. Select an object on the report.
2. Right-click on the selected object.
3. Select the "Options > Edit symbol texts" command in the context menu.

The symbol text parameter window opens.

![Symbol text parameter window](image)

4. Select one of the following options:
   - To set the appearance for all texts at once, select the "All symbol texts" item from the "Symbol text label" list.
   - To only edit a label, select it from the "Symbol text label" list.

The text that was put out at the symbol is displayed in the "Found texts" field.

5. Enter the desired changes.

6. Click "OK" to save your changes.

**Changing the text or value of the symbol**

If you only select one symbol on the report, fields appear at the top edge of the report. You can change the name, label and the description of the symbol in these fields.

![Symbol text field](image)

To save the changes, click on the **✓** button.

**19.3.4.6 Additional symbols / Subsymbols**

Some objects are configured in such a way that the symbols can be extended via the context menu. On the one hand, you can create elements. On the other hand, you can graphically extend the existing symbol of the object.

**Creating an element**

To create elements, proceed as follows:

1. Select the symbol of an object on the report.
2. Right-click on the selected object.
3. Select the "New" command from the context menu.

You can create new objects below the selected object. Here you find elements for the most part. These are objects that are normally not used as independent components but as part of another component.

4. Select an element.

5. Place the element on the report.

Extending symbols graphically

To graphically extend symbols, proceed as follows:

1. Select an object on the report.
2. Right-click on the selected object.
3. Select the "Graphical settings" command in the context menu.

Depending on the object you have selected, other items are offered in the submenu. For the valve from above, you can, for example, determine the safety position or whether it has a constant behavior; you can set the casing for containers.

Result

Your settings are saved in the attributes of the object. The symbol is accordingly extended on the report.
Example

A valve with the safety position "first remaining in position, then closed" and a container with a half pipe wall:

19.3.4.7 Freely editing symbols

Procedure

To specifically transform a symbol for the current report, proceed as follows:

1. Select the symbol on the report.
2. Right-click on the selected symbol.
3. Select the "Options > Edit symbol" command in the context menu.

The Symbol Editor opens. You find more information on this topic in the "Reports - Basic Operation" manual, keyword "Symbol Editor".

See also

Removing graphical changes (Page 148)

19.3.4.8 Removing graphical changes

All changes that were made in the Symbol Editor can be removed again in order to restore the original state.

Requirement

You have changed the symbol with the Symbol Editor.

Procedure

To undo the graphical changes, proceed as follows:

1. Select the symbol on the report.
2. Right-click on the symbol.
3. Select the "Options > Restore the original symbol" command in the context menu.
19.4 Coming up next

In COMOS this administrative work is offered as simply as possible. Above all, this applies to document revisions. A document revision is used to secure an editing state of a document and make it possible to later evaluate later.

See also

Revisions (Page 151)
19.4 Coming up next
Revisions

20.1 Revision of an individual document

20.1.1 "Revisions" tab

Buttons

You find the "Revisions" tab in the document properties.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create new revision Created by" /></td>
<td>&quot;Creates a new revision&quot; and &quot;Created by&quot;</td>
<td>Provides revision commands. See also section Carrying out a revision (Page 152).</td>
</tr>
<tr>
<td><img src="image" alt="Delete revision" /></td>
<td>&quot;Deletes the '*' revision&quot;</td>
<td>Deletes a revision if it is still open. A revision is still open as long as there is an asterisk in the &quot;Index&quot; column. You can no longer delete a closed revision.</td>
</tr>
<tr>
<td><img src="image" alt="Display selected revision" /></td>
<td>&quot;Displays the selected revision&quot;</td>
<td>Displays the saved revision file from the currently selected revision status. If an open revision is selected, the button is disabled.</td>
</tr>
<tr>
<td><img src="image" alt="Print selected revision" /></td>
<td>&quot;Prints the selected revision&quot;</td>
<td>Prints the saved revision file from the currently selected revision status. If an open revision is selected, the button is disabled.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide revision properties" /></td>
<td>&quot;Show/Hide revision properties&quot;</td>
<td>Displays or hides the revision properties. This allows you to control which text will be written to the individual revision steps.</td>
</tr>
<tr>
<td><img src="image" alt="Revision printer Info" /></td>
<td>&quot;Revision printer Info&quot;</td>
<td>Details regarding the type of the currently set revision printer driver.</td>
</tr>
</tbody>
</table>
Revisions

20.1 Revision of an individual document

Revision table

Each document has its own revision table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Index&quot;</td>
<td>The index is a unique name for a revision and also describes the chronological sequence of the revisions.</td>
</tr>
<tr>
<td>&quot;Label&quot;</td>
<td>These are the texts that relate to the revision as a whole. You can either accept the default texts or you can enter something yourself. See also section Controlling the revision text (Page 154).</td>
</tr>
<tr>
<td>&quot;Description&quot;</td>
<td>The number of these columns depends on the number of revision steps. The number of revision steps is defined by the administrator. This shows the date on which the revision step was performed and the user who carried it out.</td>
</tr>
<tr>
<td>&quot;Created by&quot;</td>
<td>Details of the relevant printer driver type that was used when the revision was created.</td>
</tr>
</tbody>
</table>

A revision table is an overview of all previously created revisions of this document. A document group can also have a revision table, See also section Revisioning a document group (Page 155).

The following table describes the individual columns of the revision table:

20.1.2 Carrying out a revision

20.1.2.1 Generating a revision

Procedure

To create a revision, click on the "Creates a new revision" button.

Result

A newly created revision gets an asterisk in the "Index" column. A new revision is also called an "open revision". A revision is only closed when the final revision step has been performed.
Project properties for revisions

There are numerous settings for revisions in the "Options > Revision options" tab of the project properties. You find more information on this topic in the "Revisions" manual, keyword "Revision properties".

20.1.2.2 Revision steps

Performing several revision steps at once

The review steps are determined by the administrator. To perform several revision steps together at one time, click directly on one of the later revision steps.

In the above illustration the first step has been skipped and the second revision step has been selected directly.

20.1.2.3 Closing a revision

Procedure

To close a revision, click on the final revision step, "Released by":

Properties of closed revisions

- You can no longer delete a closed revision.
- A closed revision is saved in a file format that cannot be changed (TIFF or PDF). That way, the revision is archived and can be accessed for inspection later.
- The "Revision archive" column remains empty for released group revisions. The revision files are saved at the individual documents and can only be opened from there.
20.1.3 **Controlling the revision text**

You can also manually enter all texts that are to be assigned to a revision.

### Procedure

To control the revision text, proceed as follows:

1. Click on the "Show/Hide revision properties" button.
   
   An input area with several fields opens. The topmost field is used to enter the description.

   ![Revision Properties](image)

   Properties of revision
   
<table>
<thead>
<tr>
<th>Label:</th>
<th>Revision description:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revision</td>
</tr>
</tbody>
</table>

2. Enter the desired text.

3. To change the text of the next revision step, enter the desired text in the fields of the "Next revision step" control group.

   ![Next Revision Step](image)

   Next revision step
   
   Revision step label:

### Result

The changes are immediately applied. If there is no entry in either the "Revision step label" field or the "Revision step description" field, the date is used as the label and the user name as the description. A single blank space is discarded and the default text is used.
20.1.4 Monitoring revisions

Procedure

To check a revision, proceed as follows:

1. Open the properties of the document.
2. On the "Revisions" tab click on the "Displays the selected revision" button.

20.2 Revisioning a document group

20.2.1 Group revision

Definition

A group revision is the revision of an object of the "Document group" type. A group revision is used to jointly carry out a revision of multiple documents in the document group. A group revision can cover all document types that can also be the subject of a revision as individual documents.

Not all document groups automatically have this revision option. If the "Revisions" tab is missing for a document group but you need it nonetheless, contact your administrator.

20.2.2 Operation

Evaluation

First, update the documents of the document group by right-clicking on the document group in the Navigator and selecting the "Evaluate documents" command.

Reason: Many documents react to changes in the engineering data. The evaluation ensures that the documents contain the latest information and avoids performing a revision of an older version.

"Revisions" tab

You revision the document group on the "Revisions" tab. See also section Carrying out a revision (Page 152).
20.2 Revisioning a document group

20.2.2.1 Effect of a group revision

General

Your administrator determines what effect a group revision has. You find more information on this topic in the "Revisions" manual, keyword "Preparing group revisions".

If a group revision was created, you see an entry in the properties of the included documents.

As long as the group revision is not concluded, you cannot revision the individual documents it contains. The corresponding buttons are disabled.

20.2.2 Deleting an open group revision

If you delete a group revision, you are asked by COMOS if the corresponding open revisions of documents should also be deleted.
20.2.3 Effective range of the group revision

20.2.3.1 Documents that have been taken in automatically

Documents

The administrator controls to what extent documents are to be included into a group revision. Nonetheless, there are a number of basic rules that even the administrator cannot change:

- Hierarchical structure

  Only documents that are directly located under the group are included in the revision. If a group has additional substructures, for example another group below the group, the documents in the lower levels are not affected.

  Sole exception: Structures that are included in the group revision with the aid of the "Grouping of documents" object. See also section Grouping of documents (Page 158).

- Documents with open revisions appear in new group revisions

  When you create a new group revision, all documents with open revisions are included. The old revision of the document is reset. All available revision steps there are discarded and the revision once again becomes an * revision. The document then becomes part of the group revision.

  The administrator determines which documents are to be included in addition to that.

20.2.3.2 Removing documents from the group revision

Procedure

To remove documents from the group revision, proceed as follows:

1. Open the properties of the document you want to delete.
2. Click on the "Revisions" tab.
3. Delete the revision of the document.
20.3 Grouping of documents

20.2.3.3 Retrospectively including documents into a group revision

Procedure

To include documents in a group revision at a later time, proceed as follows:

1. Create a new revision of the document.
2. Perform the individual revision steps until the document has the same revision step as the document group.

Result

The document is included in the group revision. The information "...is member of a revision group..." is shown in the "Revisions" tab of the document. See also section Effect of a group revision (Page 156).

20.3 Grouping of documents

Document folder

When you create a new document, the "Document package" type is also available:

- Connection, wiring plan
- Cable, pipe list
- Replacement, parts, label list
- Structure for electrical engineering
- Document package

Documents of this type are used by the other documents as ordering criterion. If you use grouped documents, the following effects arise:

- It is no longer possible to make an independent revision for the documents that are located below the grouping document. The "Revisions" tab is missing there.
- A collective revision file is created for all documents that are located below the grouping document. You find this collective revision file in the grouping document.
- Even if only one document below cannot be revisioned properly, you see a message and the revision is not carried out at all.

Procedure

To create a grouping document, proceed as follows:

1. Right-click on an object in the Navigator.
2. Select the "New > New document" command in the context menu.
3. Select the "Document package" item from the "Type" list on the "General" tab.
Result

You can create documents in the usual way underneath the grouping document. However, the documents that are located below do not have a "Revisions" tab. See also section Carrying out a revision (Page 152).

20.4 Coming up next

You can use the collective document tools to print a document. To open the collective document tools, click on the "Documents > All document tools" menu.

See also

All document tools (Page 161)
20.4 Coming up next
21.1 Searching, printing and revising documents

All document tools

You open the collective document tools via the "Extra > All document tools" menu. You here see all document tools in the toolbar.

You can directly open some tools in the toolbar via the "Documents" menu.

21.2 Using all document tools

Procedure

To use the collective document tools, proceed as follows:

1. Drag&drop an object from the Navigator into the "Start object" field.
2. Select the desired object.
3. Click on the respective button to perform the desired function.
21.3 Options

Overview

When you click on the "Options" button in the collective document tools, the "Options" window is displayed.

The following table describes the options of the window:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Search documents below documents&quot;</td>
<td>When this option is selected, documents located below other documents are displayed. If you disable this option, a search stops in a branch as soon as you reach a document.</td>
</tr>
<tr>
<td>&quot;Search documents below revisions (TIFF documents)&quot;</td>
<td>If the administrator has made the appropriate setting in the project properties, TIFF documents are printed and found.</td>
</tr>
<tr>
<td>&quot;Autom. links to 'Document with location and unit pointer'&quot;</td>
<td>Documents can have a reference to a unit and/or a location. This also produces a return reference. Return references are evaluated if this option is selected.</td>
</tr>
<tr>
<td>&quot;Autom. links to 'Engineering object with location and unit pointer'&quot;</td>
<td>The return references are evaluated if this option is selected. The links to engineering objects are traced and the search for documents is continued. The found documents are also displayed in the result list.</td>
</tr>
<tr>
<td>&quot;Enable extended functions&quot;</td>
<td>When you select this option, additional document tools are displayed in the toolbar.</td>
</tr>
</tbody>
</table>
21.4 Print

Procedure

To print, proceed as follows:
1. Select one or more documents.
2. Click on the "Print" button.

21.5 Revisioning

Buttons

You need the following buttons in the collective document tools to perform revisioning:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>&quot;Evaluate documents&quot;</td>
<td>Starts the evaluation of the documents</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>&quot;Revision...&quot;</td>
<td>Creates a revision step for all selected documents. If a document in the selection has a higher revision step, it is retained. If a document has a lower revision step or no open revision, a revision is created as required and set to the selected step. See also section Carrying out a revision (Page 152).</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>&quot;Copy TIFF/PDF file of the released revision...&quot;</td>
<td>The existing revision file is copied and stored at the location you specified.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>&quot;Print current revision file&quot;</td>
<td>Prints the last released revision file of the selected documents. If the document has no released revision file it will be skipped.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>&quot;Print with revision printer&quot;</td>
<td>Saves the selected report with the desired option in a by you specified file directory.</td>
</tr>
</tbody>
</table>

See also

Revisions (Page 151)
21.6 Other buttons

The collective document tools are based on an object query. See also section Object queries (Page 103).

Buttons

The following additional buttons are available in the collective documents tools:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>&quot;DWG/DFX Export ...&quot;</td>
<td>Saves the selected documents as DWG or DXF files.</td>
</tr>
<tr>
<td>![Image]</td>
<td>&quot;Word Export ...&quot;</td>
<td>Exports the selected evaluation reports to Word.</td>
</tr>
<tr>
<td>![Image]</td>
<td>&quot;Excel Export ...&quot;</td>
<td>Exports the selected evaluation reports to Excel.</td>
</tr>
<tr>
<td>![Image]</td>
<td>&quot;PDF Export ...&quot;</td>
<td>Exports the selected evaluation reports to PDF.</td>
</tr>
</tbody>
</table>
Switching language

22.1 General

User interface and project

The language is set separately for two areas in COMOS:

- Program interface
  
  This includes the user interface of COMOS, the interfaces of all windows, the messages or warnings as well as the tooltips. In addition, the PDF help is offered in the foreign language if there are help files in this language. See also section Switching the user interface language (Page 166).

- Content of the project
  
  This concerns objects in the database. Almost all texts that can be input by a user are translated:
  
  - Description
  - Attribute values
  - List fields and memo fields
  - Help texts and tooltip texts of attributes
  - Fixed texts in reports
  - Column headers of object queries

  This switches all texts in the Navigator. Furthermore, the object texts are also displayed in the selected language in all windows. See also section Switching the project language (Page 166).

The combinations between the user interface language and the project language is arbitrary. Generally, you select the same language for the user interface and the project.

The selected settings apply to the respective workplace.

This COMOS property enables multinational participants to work together on joint projects in their own respective languages.
22.2 Switching the user interface language

Procedure

To switch the user interface language, proceed as follows:

1. Click "File > Languages".
   The "Languages" window is displayed.
2. Select the desired language.
3. Click "OK".

Result

The language is changed. This action closes all open documents and properties.

22.3 Switching the project language

Procedure

To switch the project language, proceed as follows:

1. Right-click on a project.
2. Select the "Properties" command in the context menu.
   The project properties are displayed.
3. Click on the "Languages" tab.
4. Enable the option for the desired language in the "Current" or "User defaults" column.

<table>
<thead>
<tr>
<th>General</th>
<th>Links</th>
<th>Options</th>
<th>Languages</th>
<th>Cases</th>
<th>Fulltext index</th>
<th>PDMS Interface/construction assistant</th>
<th>Project data</th>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Support languages
- The first existing text will be displayed if own and primary language text are blank.

<table>
<thead>
<tr>
<th>Current</th>
<th>Current user</th>
<th>Project structure</th>
<th>Project relevant</th>
<th>Primary language</th>
<th>Local ID</th>
<th>Description</th>
<th>Decimal delimiter</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>1031</td>
<td>German</td>
<td>(Comma)</td>
</tr>
<tr>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td>1033</td>
<td>English</td>
<td>(Point)</td>
</tr>
<tr>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td>1035</td>
<td>French</td>
<td>(Comma)</td>
</tr>
<tr>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
<td>2052</td>
<td>Chinese (PRC)</td>
<td>(Point)</td>
</tr>
</tbody>
</table>

5. Click "OK" to apply your settings.

**Result**

The project language is changed.

**Columns**

The following table describes the relevant columns of the "Language" tab:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Current&quot;</td>
<td>Here you set the project language for the current session. If you close and reopen COMOS, the default settings in the &quot;User defaults&quot; apply again.</td>
</tr>
<tr>
<td>&quot;User default&quot;</td>
<td>Displays the default for the logged in user.</td>
</tr>
<tr>
<td>&quot;Project structure&quot;</td>
<td>All workstations that open this project initially see the texts of the project in this language.</td>
</tr>
<tr>
<td>&quot;Project relevant&quot;</td>
<td>For determining the relevant languages for a project. When this option is selected, you can only switch between the languages relevant to the project in the &quot;Languages&quot; tab.</td>
</tr>
</tbody>
</table>
Switching the project language

---

22.3 Switching the project language